About This Guide

Welcome to ADAMS/Car

Welcome to ADAMS/Car, Mechanical Dynamics’ (MDI) virtual prototyping software. ADAMS/Car creates, catalogues, and analyzes suspension and vehicle assemblies. Using ADAMS/Car, you can build and alter suspensions, steering subsystems, and vehicles. You can then analyze them to understand their elasto-kinematic and dynamic behavior.

Contents of This Guide

If you’ve never used ADAMS/Car before, this guide is a good place to start learning about ADAMS/Car. As you work through the four step-by-step tutorials that we have provided in this guide, you will learn most of the basic concepts and tasks that you can perform using ADAMS/Car.

What This Guide Assumes

This guide assumes that ADAMS/Car is installed on your computer or network. It also assumes that your path variable contains the location where ADAMS/Car is installed and that you have permission to execute ADAMS/Car. If you do not know if ADAMS/Car is installed or where it is located, see your local ADAMS/Car expert or system administrator.
Introducing ADAMS/Car

Overview

This chapter introduces you to ADAMS/Car and explains how you can benefit from using it. It also explains how you can learn more about ADAMS/Car and introduces the tutorials that we’ve included in this guide to help you become familiar with ADAMS/Car.

This chapter contains the following sections:

- What is ADAMS/Car?, 6
- What You Can Do with ADAMS/Car, 7
- How You Benefit from Using ADAMS/Car, 8
- Starting ADAMS/Car Standard Interface, 9
- Starting ADAMS/Car Template Builder, 11
- Familiarizing Yourself with ADAMS/Car, 13
- Plotting Results, 15
- About the Tutorials, 16
- Getting Help Online, 17
What is ADAMS/Car?

ADAMS/Car is a specialized environment for modeling vehicles. It allows you to create virtual prototypes of vehicle subsystems, and analyze the virtual prototypes much like you would analyze the physical prototypes.

The ADAMS/Car model hierarchy is comprised of the following components, which are stored in databases:

- **Templates** - Are ADAMS/Car models built in ADAMS/Car Template Builder by users who have expert privileges. Templates are parameterized and generally are topological representations of vehicle subsystems, which can include front suspensions, brakes, chassis, and so on.
  
  You save templates in ASCII or binary format.

- **Subsystems** - Are based on ADAMS/Car templates and allow standard users to change the parametric data of the template. For example, you can change the location of hardpoints, modify parameter variables, and so on.
  
  You save subsystems in ASCII format.

- **Assemblies** - Are comprised of subsystems that can be grouped together to form suspension assemblies, full-vehicle assemblies, and so on.
  
  You save assemblies in ASCII format.

ADAMS/Car has two modes:

- **Standard Interface** - You use it when working with existing templates to create and analyze assemblies of suspensions and full vehicles. Both standard users and expert users can use ADAMS/Car Standard Interface.

- **Template Builder** - If you have expert user privileges, you use ADAMS/Car Template Builder to create new templates for use in ADAMS/Car Standard Interface.

When you create a new component in the Template Builder, ADAMS/Car automatically adds a prefix based on the entity type and the symmetry. ADAMS/Car uses a naming convention to let you easily determine an entity’s type from the entity’s name. For more information on the naming convention and a table that lists the prefixes of ADAMS/Car entities, see About the Naming Convention on page 14 in the guide, Component Descriptions.
What You Can Do with ADAMS/Car

Using ADAMS/Car, you can quickly create assemblies of suspensions and full vehicles, and then analyze them to understand their performance and behavior.

You create assemblies in ADAMS/Car by defining vehicle subsystems, such as front and rear suspensions, steering gears, anti-roll bars, and bodies. You base these subsystems on their corresponding standard ADAMS/Car templates. For example, ADAMS/Car includes templates for double-wishbone suspension, MacPherson strut suspension, rack-and-pinion steering, and so on.

If you have expert user privileges, you can also base your subsystems on custom templates that you create using the ADAMS/Car Template Builder.

When you analyze an assembly, ADAMS/Car applies the analysis inputs that you specify. For example, for a suspension analysis you can specify inputs to:

- Move the wheels through bump-rebound travel and measure the toe, camber, wheel rate, roll rate, and side-view swing arm length.
- Apply lateral load and aligning torque at the tire contact path and measure the toe change and lateral deflection of the wheel.
- Rotate the steering wheel from lock to lock and measure the steer angles of the wheels and the amount of Ackerman, that is, the difference between the left and right wheel steer angles.

Based on the analysis results, you can quickly alter the suspension geometry or the spring rates and analyze the suspension again to evaluate the effects of the alterations. For example, you can quickly change a rear suspension from a trailing-link to a multi-link topology to see which yields the best handling characteristics for your vehicle.

Once you complete the analysis of your model, you can share your work with others. You can also print plots of the suspension characteristics and vehicle dynamic responses. In addition, you can access other users’ models without overwriting their data.
How You Benefit from Using ADAMS/Car

ADAMS/Car enables you to work faster and smarter, letting you have more time to study and understand how design changes affect vehicle performance. Using ADAMS/Car you can:

- Explore the performance of your design and refine your design before building and testing a physical prototype.
- Analyze design changes much faster and at a lower cost than physical prototype testing would require. For example, you can change springs with a few mouse clicks instead of waiting for a mechanic to install new ones in your physical prototype before re-evaluating your design.
- Vary the kinds of analyses faster and more easily than if you had to modify instrumentation, test fixtures, and test procedures.
- Work in a more secure environment without the fear of losing data from instrument failure or losing testing time because of poor weather conditions.
- Run analyses and what-if scenarios without the dangers associated with physical testing.
Starting ADAMS/Car Standard Interface

In this section, you learn how to start ADAMS/Car Standard Interface in the Windows and the UNIX environments.

In the Windows environment, you start ADAMS/Car from the Start button. For more information, see the guide, *Running ADAMS on Windows*.

In the UNIX environment, you start ADAMS/Car from the ADAMS Toolbar. For information on the ADAMS Toolbar, see the guide, *Running and Configuring ADAMS on UNIX*.

To start ADAMS/Car in the Windows environment:

1. From the Start menu, point to Programs, point to ADAMS 12.0, point to ACar, and then select ADAMS - Car (view).
   The Welcome dialog box appears on top of the ADAMS/Car main window.

2. Do one of the following:
   - If the Welcome dialog box contains the options Standard Interface and Template Builder, select Standard Interface, and then select OK.
   - If the Welcome dialog box does not contain any options, then ADAMS/Car is already configured to run in standard mode. Select OK.

   The ADAMS/Car main window appears as shown in Figure 2 on page 13.
To start ADAMS/Car in the UNIX environment:

1. At the command prompt, enter the command to start the ADAMS Toolbar, and then press Enter. The standard command that MDI provides is adamsx, where x is the version number, for example adams12.

   The ADAMS Toolbar appears.

2. Select the ADAMS/Car tool.

   The Welcome dialog box appears on top of the ADAMS/Car main window.

3. Do one of the following:
   - If the Welcome dialog box contains the options Standard Interface and Template Builder, select Standard Interface, and then select OK.
   - If the Welcome dialog box does not contain any options, then ADAMS/Car is already configured to run in standard mode. Select OK.

   The ADAMS/Car main window appears as shown in Figure 2 on page 13.
Starting ADAMS/Car Template Builder

In this section, you start the ADAMS/Car Template Builder and begin working in template-builder mode.

Before you start ADAMS/Car Template Builder, make sure that your private configuration file, .acar.cfg, shows that you can work in expert-user mode. Your private configuration file is located in your home directory.

To check the user mode:

1. In a text editor, such as jot or notepad, open .acar.cfg.
2. Verify that the following line appears as shown:
   ```
   ENVIRONMENT MDI_ACAR_USERMODE expert
   ```
   This line sets the user mode for the ADAMS/Car session.

To start ADAMS/Car in the Windows environment:

1. From the Start menu, point to Programs, point to ADAMS 12, point to ACar, and then select ADAMS - Car (view).
   The Welcome dialog box appears on top of the ADAMS/Car main window.
2. Select Template Builder.
3. Select OK.
   The ADAMS/Car Template Builder window looks very similar to the ADAMS/Car Standard Interface window, as shown in Figure 1 on page 12.
To start ADAMS/Car in the UNIX environment:

1. At the command prompt, enter the command to start the ADAMS Toolbar, and then press Enter. The standard command that MDI provides is adamsx, where x is the version number, for example, adams12. The ADAMS Toolbar appears.

2. Click the ADAMS/Car tool 🚗. The Welcome dialog box appears on top of the ADAMS/Car main window.


4. Select OK.

The ADAMS/Car Template Builder window looks very similar to the ADAMS/Car Standard Interface window, as shown next.

Figure 1. ADAMS/Car Template Builder
Familiarizing Yourself with ADAMS/Car

Take a few minutes to familiarize yourself with the ADAMS/Car main window.

The following tips help you quickly become familiar with ADAMS/Car:

- You use the menus along the top of the window to execute commands and display dialog boxes. Notice that some menus are shaded in grey. This indicates that you cannot execute these commands because you do not have a subsystem open. When you open a subsystem, these menus change to black indicating that you can execute the commands.
You can use the main pop-up menu to execute simple commands, such as rotating views, zooming, and fitting assemblies in the main window. To display the main pop-up menu, right-click in the main window, away from any entities.

Instead of manually entering text in boxes that require database objects, you can have ADAMS/Car automatically do this task for you. To do this, right-click the text box of interest, and then select an option. For example, if you were modifying a hardpoint, ADAMS/Car would present you with the following options:

- Point to **Hardpoint** (or the entity of interest) and then select **Pick**. On the main window, place the cursor on top of the hardpoint. When the color of the hardpoint changes, you can click the left mouse button to select that hardpoint.
- Point to **Hardpoint**, and then select **Guesses**. From the pop-up menu that appears, select the entity name you want to use.
- Point to **Hardpoint**, and then select **Browse**. ADAMS/Car displays the Database Navigator, which contains a list of entities, hardpoints in this case. Double-click the entity name you want to use.
Plotting Results

When you’re ready to review the results of your analyses, you can display the post-processing tool and view the results of the simulations you performed.

To plot results:


   ADAMS/Car launches ADAMS/PostProcessor, as shown in Figure 3. ADAMS/PostProcessor has three modes: plotting (default), animation, and report, as shown in the first option menu on the menu toolbar.

   For detailed information about ADAMS/PostProcessor, see the guide, Using ADAMS/PostProcessor.

   Figure 3. ADAMS/PostProcessor

2. To return to ADAMS/Car, select the Return to Modeling Environment tool or press F8.
About the Tutorials

We assume that you will work through the tutorials in sequential order. Therefore, we give you more guidance in the beginning and less as you proceed through each tutorial.

**Note**: If you choose not to work through the tutorials in sequential order, you may have to reference earlier tutorials for some of the basic concepts.

- **Suspension Analysis Tutorial** - Teaches you how to perform the following operations in ADAMS/Car Standard Interface:
  - Create subsystems by combining templates and data.
  - Modify the subsystems, such as changing the position of a component part.
  - Create and analyze assemblies.
  - Animate and plot analysis results and compare the results of one analysis to the results of another.

- **Full-Vehicle Analysis Tutorial** - Teaches you how to analyze a full vehicle and uses many of ADAMS/Car advanced features.

- **Flexible Bodies Tutorial** - Teaches you how to work with flexible bodies in an ADAMS/Car assembly.

- **Template Builder Tutorial** - Gives you an overview of using the Template Builder. In this tutorial, you create a suspension template using the basic building blocks of ADAMS/Car Template Builder.
Getting Help Online

When working in ADAMS/Car, you can get help as follows:

- From the Help menu, select ADAMS/Car Help.
- While working in any dialog box, press the F1 key.
- From any of the online guides, select the Help on Help bookmark.
Overview

This tutorial teaches you how to modify and analyze a double-wishbone suspension.

This chapter includes the following sections:

- What You Will Create and Analyze, 20
- Setting Up the Suspension and Steering Subsystems, 21
- Performing a Baseline Parallel Wheel Travel Analysis, 25
- Performing a Baseline Pull Analysis, 31
- Modifying the Suspension and Steering Subsystem, 42
- Performing an Analysis on the Modified Assembly, 45
- Comparing the Analysis Results, 46
- Finishing Up, 48

This tutorial takes about one hour to complete.
What You Will Create and Analyze

During this tutorial, you analyze and modify an assembly of a front suspension and steering subsystem. To perform the analysis, you must first create a double-wishbone suspension and steering subsystem from standard ADAMS/Car templates and subsystems. ADAMS/Car templates define a subsystem’s topology and specify how one subsystem connects to another. Templates also contain default parameters, such as locations, part masses, and inertias.

Figure 4 shows the suspension and steering assembly (in shaded mode) that you will analyze and modify.

Figure 4. Suspension and Steering Assembly
After you create the suspension and steering assembly, you perform two types of analyses to understand its kinematics:

- A baseline parallel wheel travel analysis that moves the assembly vertically through the suspension’s rebound-bump travel.
- A baseline pull analysis to measure the brake pull at the steering wheel.

Once you understand the kinematics of the assembly, you modify the suspension subsystem’s geometry to decrease the scrub radius, which should reduce the pull on the steering wheel. You confirm the reduction by analyzing the modified assembly again, using the same type of analysis and comparing the new results to the results yielded by the previous analysis.

**Setting Up the Suspension and Steering Subsystems**

In this section, you work with a suspension and steering assembly from two subsystems: a suspension subsystem and a steering subsystem. You create the suspension subsystem using the standard double-wishbone template. You don’t need to create the steering subsystem. Instead, you can open an existing subsystem that we’ve provided.

After creating and opening the subsystems, you create an assembly that contains the subsystems and a test rig.

Completing this section involves the following:

- **Creating a New Front Suspension Subsystem**, 22
- **Creating a Suspension and Steering Assembly**, 24
Creating a New Front Suspension Subsystem

You create the front suspension subsystem based on a double-wishbone design stored in the standard template named _double_wishbone.tpl, and then save it.

After you create the subsystem, you save it in an ADAMS/Car database. When you save a subsystem, ADAMS/Car stores it in the database designated as the default writable database. Initially, the private database is the default writable database, but as you become more familiar with ADAMS/Car, you can change your writable database. Later, when you are sure the design is complete or ready for review, you can have your database administrator save the file in a shared database or allow others to access it from your private database.

To create the front suspension subsystem:

2. From the File menu, point to New, and then select Subsystem.
   The New Subsystem dialog box appears.
3. In the Subsystem Name text box, enter UAN_FRT_SUSP.
4. Set Minor Role to front. A minor role defines the subsystem’s function and its placement in the assembly (for example, front or rear). In this case, you select front because you are creating a front suspension.
5. Right-click the Template Name text box, point to Search, and then select the shared database.
   The File Selection dialog box appears.
   The Template Name text box now contains the file _double_wishbone.tpl and an alias to its directory path.
7. Verify that Translate from default position is not selected.
8. Select the Comment tool .
   The Modify Comment dialog box appears.
9. In the Comment Text text box, enter Baseline UAN Front Suspension.

10. Select OK.

11. Select OK again.

ADAMS/Car creates the suspension subsystem using the default data contained in the template and displays it as shown next:

**Figure 5. Suspension Subsystem**
To save the suspension subsystem:

1. From the File menu, point to Save, and then select Subsystem.
   The Save Subsystem dialog box appears. The subsystem UAN_FRT_SUSP should already be displayed next to Subsystem Name, because it is the only subsystem you currently have open.

2. Verify that Close subsystem after save is not selected so that ADAMS/Car does not close the subsystem.

3. Select OK.
   ADAMS/Car saves the subsystem in your default writable database, which might be your private database. For more information on databases, see the guide, Configuring Template-Based Products.

Creating a Suspension and Steering Assembly

In this section, you create a new suspension assembly and add to it a steering subsystem.

To create the suspension and steering assembly:

1. From the File menu, point to New, and then select Suspension Assembly.
   The New Suspension Assembly dialog box appears.

2. In the Assembly Name text box, enter my_assembly.

3. Click the folder icon next to Suspension Subsystem.
   The name of the suspension subsystem you just created appears.

4. Select Steering Subsystem.

5. Right-click the Steering Subsystem text box, point to Search, and then select the shared database.
   The File Selection dialog box appears.
6 Double-click `MDI_FRONT_STEERING.sub`.

The Steering Subsystem text box now contains `MDI_FRONT_STEERING.sub` and an alias to its directory path.

Note that by default ADAMS/Car selects a test rig for the assembly, `_MDI_SUSPENSION_TESTRIG`.

7 Select OK.

The Message window appears, informing you of the steps ADAMS/Car takes when creating the assembly.

ADAMS/Car displays the suspension and steering assembly in the main window, as shown in Figure 4 on page 20.

8 Select Close, to close the Message window.

Performing a Baseline Parallel Wheel Travel Analysis

You now perform a parallel wheel travel analysis on the suspension and steering assembly, and then plot and view the results, as explained in the following sections:

- Defining Vehicle Parameters, 25
- Performing the Analysis, 27
- Animating the Results, 28
- Plotting the Results, 29

Defining Vehicle Parameters

Before performing a suspension analysis, you must specify several parameters about the vehicle in which you intend to use the suspension and steering subsystems. These parameters include the vehicle’s wheel base and sprung mass, whether or not the suspension is front- or rear-wheel drive, and the braking ratio. For this analysis, you enter the parameters to indicate front-wheel drive and a brake ratio of 64% front and 36% rear.
To define vehicle parameters:

1. From the Simulate menu, point to Suspension Analysis, and then select Set Suspension Parameters.

The Suspension Analysis: Setup Parameters dialog box appears. It contains default settings to help you quickly set up a suspension analysis.

2. Set up the analysis as follows:
   - Suspension Assembly: my_assembly
   - Tire Model: User Defined
   - Tire Unloaded Radius: 300
   - Tire Stiffness: 200
   - Wheel Mass: 1.0
   - Sprung Mass: 1400
   - CG Height: 300
   - Wheelbase: 2765
   - Drive Ratio: 100

   All driving force is applied to the front wheels.
   - Brake Ratio: 64

   The brake ratio value indicates the % of braking force that is applied to the front brakes.

3. Select OK.

Tip: For more information on any dialog box, press F1 when the dialog box is active.
Performing the Analysis

Now that you’ve defined the vehicle parameters, you can run the parallel wheel travel analysis. During the analysis, the test rig applies either forces or displacements to the assembly, as defined in a loadcase file. For this analysis, ADAMS/Car generates a temporary loadcase file based on the inputs you specify.

The parallel wheel travel analysis moves the wheel centers from -100 mm to +100 mm relative to their input position, while holding the steering fixed. During the wheel motion, ADAMS/Car calculates many suspension characteristics, such as camber and toe angle, wheel rate, and roll center height.

To perform the analysis:

1. From the Simulate menu, point to Suspension Analysis, and then select Parallel Wheel Travel.
2. Set up the analysis as follows:
   - Suspension Assembly: my_assembly
   - Output Prefix: baseline
   - Number of Steps: 15
   - Mode of Simulation: interactive
   - Bump Travel: 100
   - Rebound Travel: -100
   - Travel Relative To: Wheel Center
   - Steering Input: Angle
3. Select the Comment tool.
4. In the Comment Text text box, enter Baseline Parallel Wheel Travel Analysis.
5. Select OK.
Select **OK** again.

*Tip:* For more information on any dialog box, press **F1** when the dialog box is active.

The Message window appears, informing you of the steps ADAMS/Car takes when performing the analysis. ADAMS/Car analyzes the suspension and steering assembly and applies to it the displacements and loads defined in the submission dialog box.

When the analysis is complete, select **Close**.

### Animating the Results

In this section, you view the analysis you just ran. ADAMS/Car has already loaded the animation and graphic files for you.

#### To animate the results:

1. From the **Review** menu, select **Animation Controls**.
2. Select the **Play** tool 

   ADAMS/Car animates the motion of the suspension analysis. Notice that the suspension moves from rebound (down), to bump (up), and that the steering wheel does not rotate.
3. When the animation is complete, close the dialog box.
Plotting the Results

In this section, you create several plots from the parallel wheel travel analysis results. In a plot configuration file, we have provided all the information that ADAMS/Car needs to create the plots. The plot configuration file not only specifies which plots ADAMS/Car should create, but also how the plots should look, including their horizontal and vertical units, and colors. Storing plotting information in a plot configuration file lets you quickly regenerate plots after each analysis.

To plot the results:

1. From the Review menu, select Postprocessing Window or press F8.
   
   ADAMS/Car launches ADAMS/PostProcessor, as shown in Figure 3 on page 15. ADAMS/PostProcessor has three modes: plotting (default), animation, and report, as shown in the first option menu on the menu toolbar.

   For detailed information about ADAMS/PostProcessor, see the guide, Using ADAMS/PostProcessor.

2. From the Plot menu, select Create Plots.

3. Enter the following specifications:
   
   ❖ Plot Configuration File:  
   
   ❖ Plot Title: Baseline Parallel Travel Analysis - UAN_FRT_SUSP

4. Select OK.
   
   ADAMS/Car creates the plots. To cycle through the plots, from the Main toolbar, use the Previous Pages and Next Pages tools.

5. View the plot named Scrub Radius, shown in Figure 6. Scrub radius is the distance from the point at the intersection of the steering axis (also known as the kingpin axis) and the ground plane, to the line of intersection of the wheel and ground planes.
Notice that the scrub radius varies little with wheel travel and is approximately 32 mm. A positive scrub radius means the steering axis lies inboard of the center of the tire contact patch.

From the analysis you’ve completed, you have enough information to calculate the approximate torques produced about the steering axes using the difference in left to right braking forces and the 32 mm scrub radius.

In addition, using the results of that calculation and the steering geometry, you can calculate the resulting unbalanced force at the steering rack and the pull (torque) needed at the steering wheel to keep the wheels straight.

In the next sections, you use ADAMS/Car to perform these calculations.
Deleting Plots

To prepare for the baseline pull analysis, delete the plots you created in the previous sections.

To delete plots:

1. In the treeview, hold down the left mouse button, and then drag the cursor across the names of the plots you want to delete.
2. From the Edit menu, select Delete.
3. From the File menu, select Close Plot Window or press F8.

ADAMS/Car returns to the main window.

Performing a Baseline Pull Analysis

You can now perform a baseline pull analysis to study the pull on the steering wheel. You will use the results of this pull analysis as the baseline against which you compare the results of another pull analysis that you perform after you modify the location of the steering axis. By comparing the results from the two analyses, you can determine if the modifications were successful.

Performing a baseline pull analysis involves the following:

- Defining a Loadcase File, 32
- Performing the Analysis, 35
- Animating the Results, 35
- Plotting the Results, 36
- Saving the Plot Configuration, 42
Defining a Loadcase File

Before you can run the baseline pull analysis, you need to create a loadcase file to drive the analysis. In the loadcase file, you specify the unequal braking forces to simulate braking on a split-µ surface and the beginning, or upper, and ending, or lower, steering wheel angles.

To calculate the unequal brake forces, we assume that the vehicle is braking at a rate of 0.5 g’s deceleration, with a 64% front and 36% rear brake ratio, a vehicle mass of 1,400 kg, and the front braking force split 55% left and 45% right. Based on these assumptions, the total front braking force is:

\[
1,400 \text{ kg} \times 0.5 \text{ g’s} \times 9.81 \text{ m/s}^2/\text{g} \times 0.64 = 4,395 \text{ N}
\]

From this, the left and right braking forces are:

- Left braking force = 0.55 × 4,395 N or 2,417 N
- Right braking force = 4,395 N - 2,417 N or 1,978 N

You can use these calculations to define the loadcase file.

To define a loadcase file:

1. From the Simulate menu, point to Suspension Analysis, and then select Create Loadcase.

   Note: If Select Loadcase Type is not set to Static Load, your dialog box will look slightly different. Make sure you select Static Load first, and then proceed to fill in the dialog box.

2. Fill in the dialog box as shown next, and then select OK.
ADAMS/Car creates the loadcase file, named brake_pull.ldf, and stores it in your private database. It stores the loadcase file as text (ASCII) and you can print it or edit it manually.

To create the loadcase file, ADAMS/Car takes the parameters that you entered and generates a table of input values. For the parameters that you entered, ADAMS/Car generates a table that varies steering wheel angle from -180 to 180 in 15 steps, while holding the braking forces constant.
Table 1 shows the loadcase file values:

<table>
<thead>
<tr>
<th>Steering Wheel:</th>
<th>Left Brake Force:</th>
<th>Right Brake Force:</th>
</tr>
</thead>
<tbody>
<tr>
<td>-180</td>
<td>2417</td>
<td>1978</td>
</tr>
<tr>
<td>-156</td>
<td>2417</td>
<td>1978</td>
</tr>
<tr>
<td>-132</td>
<td>2417</td>
<td>1978</td>
</tr>
<tr>
<td>-108</td>
<td>2417</td>
<td>1978</td>
</tr>
<tr>
<td>-84</td>
<td>2417</td>
<td>1978</td>
</tr>
<tr>
<td>-60</td>
<td>2417</td>
<td>1978</td>
</tr>
<tr>
<td>-36</td>
<td>2417</td>
<td>1978</td>
</tr>
<tr>
<td>-12</td>
<td>2417</td>
<td>1978</td>
</tr>
<tr>
<td>12</td>
<td>2417</td>
<td>1978</td>
</tr>
<tr>
<td>36</td>
<td>2417</td>
<td>1978</td>
</tr>
<tr>
<td>60</td>
<td>2417</td>
<td>1978</td>
</tr>
<tr>
<td>84</td>
<td>2417</td>
<td>1978</td>
</tr>
<tr>
<td>108</td>
<td>2417</td>
<td>1978</td>
</tr>
<tr>
<td>132</td>
<td>2417</td>
<td>1978</td>
</tr>
<tr>
<td>156</td>
<td>2417</td>
<td>1978</td>
</tr>
<tr>
<td>180</td>
<td>2417</td>
<td>1978</td>
</tr>
</tbody>
</table>
Performing the Analysis

You can now use the loadcase file that you just created to perform an analysis that determines the pull characteristics of the suspension and steering assembly.

To perform the pull analysis:

1. From the Simulate menu, point to Suspension Analysis, and then select External Files.
2. Set up the analysis as follows:
   - Suspension Assembly: my_assembly
   - Output Prefix: baseline
   - Mode of Simulation: interactive
   - Loadcase Files: mdids://private/loadcases.tbl/brake_pull.lcf
3. Make sure Load Analysis Results is selected.
4. Clear the selection of Create Analysis Log File.
5. Select the Comment tool.
6. In the Comment Text text box, enter Baseline Pull Analysis.
7. Select OK.
8. Select OK again.

Animating the Results

In this section, you view an animation of the analysis ADAMS/Car just performed.

To animate the results:

1. From the Review menu, select Animation Controls.
2. Select the Play tool.
   - ADAMS/Car animates the turning motion of the steering subsystem. You should see the wheels turn as the steering wheel rotates. The wheel centers should not move vertically.
3. Close the Animation Controls dialog box.
Plotting the Results

You can now use the results from the baseline pull analysis to create two plots, as explained in the following sections:

- Plotting Steering Wheel Torque versus Steering Wheel Angle, 36
- Plotting Scrub Radius versus Steering Wheel Angle, 39

**Plotting Steering Wheel Torque versus Steering Wheel Angle**

You now create a plot of the steering wheel torque versus the steering wheel angle.

**To set up the plot:**

1. Launch ADAMS/PostProcessor just as you did on page 29.
2. From the treeview, double-click page_1.
3. Select plot_1.
4. In the property editor, clear the selection of Auto Title and Auto Subtitle.
5. In the Title text box, enter Brake Pull Analysis.
6. In the Subtitle text box, enter Steering Wheel Torque vs Steering Wheel Angle.
7. Right-click the treeview area, point to Type Filter, point to Plotting, and then select Axes.
8. From the treeview, double-click plot_1, and then select haxis.
9. In the property editor, select the Labels tab.
10. In the Label text box, enter Steering Wheel Angle [degrees].
11. From the treeview, select vaxis.
12. In the Label text box, enter Steering Wheel Torque [Nmm].
To create the plot:

1. Verify that `Source` is set to `Requests`. ADAMS/Car automatically displays data information.
2. From the `Simulation` list, select `baseline_brake_pull`.
3. From the right of the dashboard, set `Independent Axis` to `Data`. The Independent Axis Browser appears. You perform the next four steps in the browser.
4. From the `Filter` list, select `user defined`.
5. From the `Request` list, select `steering_displacements`. You might have to scroll down to see this entry.
6. From the `Component` list, select `angle_front`.
7. Select `OK`.
8. From the `Filter` list, select `user defined`.
9. From the `Request` list, select `steering_wheel_input`.
10. From the `Component` list, select `steering_wheel_input_torque`. 
11 Select Add Curves.

ADAMS/Car takes the data requested and automatically generates the curve on the current plot template, as shown next:

**Figure 7. Plot of Steering Wheel Torque versus Steering Wheel Angle**

The plot shows the torque that the test rig applies to the steering wheel to hold the wheel in position. The torque is negative, meaning that the test rig applies a clockwise torque to counteract the unequal braking force that pulls the wheel counterclockwise, as if making a left turn.
Plotting Scrub Radius versus Steering Wheel Angle

In this section, you create a plot of the scrub radius versus the steering wheel angle. After you create the plot, you can modify it to change the number of divisions in the vertical and horizontal axes so they cover a larger range and define the minimum and maximum limits to be displayed in the vertical axis.

To set up the plot:

1. From the Main toolbar, select the New Page tool.
2. In the treeview, double-click page_2.
3. Select plot_2.
4. Make sure that Auto Title and Auto Subtitle are not selected.
5. In the Title text box, enter Brake Pull Analysis.
6. In the Subtitle text box, enter Scrub Radius vs Steering Angle.
7. Right-click the treeview area, point to Type Filter, point to Plotting, and then select Axes.
8. Double-click plot_2 to expand it so the names of the axes are visible.
9. From the treeview, select haxis.
10. In the property editor, select Labels.
11. In the Label text box, enter Steering Wheel Angle [degrees].
12. From the treeview, select vaxis.
13. In the Label text box, enter Scrub Radius [mm].

To create the plot:

1. Verify that Source is set to Requests.
2. From the Simulation list, select baseline_brake_pull.
3. From the Filter list, select user defined.
4. From the Request list, select scrub_radius.
5. From the Component list, select left.
This defines the vertical axis component.

6. Select Add Curves.
ADAMS/Car takes the data requested and generates the curve on the current plot template, as shown next:

**Figure 8. Plot of Scrub Radius versus Steering Angle**

Notice that the scrub radius appears to vary a lot with respect to the steering angle because of the vertical plot scale, when in fact it only varies 0.21 mm over the total range of steering wheel angle. To show that this variation is small, you must modify the vertical axis so it covers a larger range of values.
To modify the plot:

1. Select the vertical axis.
2. From the property editor, select the **Format** tab.
3. Clear the selection of **Auto Scale**.
4. In the **Limits** text boxes, enter 0 and 100.

A modified plot appears as shown next.

**Figure 9. Modified Plot of Scrub Radius versus Steering Wheel Angle**

Notice that the variation in scrub radius with respect to the steering wheel angle now appears smaller.
Saving the Plot Configuration

Saving the changes that you made to the plots in a plot configuration file lets you easily recreate the plots later in this tutorial, after you modify the suspension and steering assembly.

To save the plot configuration:

1. From the File menu, point to Export, and then select Plot Configuration File.
2. In the Configuration File Name text box, enter brake_pull.
3. Make sure All Plots is selected.
4. Select OK.
5. From the File menu, select Close Plot Window.

ADAMS/Car returns to the main window.

Modifying the Suspension and Steering Subsystem

For a double-wishbone suspension, the line running from the lower spherical joint to the upper spherical joint defines the steering axis or kingpin axis. If these joints move outboard while the rest of the suspension geometry remains unchanged, the scrub radius is decreased.

In the suspension subsystem that you created, two hardpoint pairs define the locations of these joints:

- **hpl_lca_outer** and **hpr_lca_outer**, where **lca_outer** means lower control arm outer, and the prefix **hpl** means hardpoint left and the prefix **hpr** means hardpoint right.

- **hpl_uca_outer** and **hpr_uca_outer**, where **uca_outer** means upper control arm outer and the prefix **hpl** means hardpoint left and the prefix **hpr** means hardpoint right.

Hardpoints define independent locations in space.
To decrease the scrub radius, you modify the locations that these hardpoints define, as explained in the following sections:

- Modifying Hardpoint Locations, 43
- Saving the Modified Subsystem, 44

Modifying Hardpoint Locations

You must first display a table that contains data about the current locations that the hardpoints define. You can then modify the hardpoint locations. You only need to indicate how you want to move the left hardpoints in each pair, and ADAMS/Car modifies the right hardpoints accordingly.

To view hardpoint locations:

1. From the View menu, select Subsystem.
   
   The Display Subsystem dialog box appears, already containing the subsystem my_assembly.UAN_FRT_SUSP.
2. Select OK.
3. From the Adjust menu, point to Hardpoint, and then select Table.
   
   The Hardpoint Modification Table appears. It displays the locations of all the hardpoints in the assembly. You can use this table to display and modify the locations of any of the hardpoints.

   The locations of the paired hardpoints differ only by the sign of the Y location. Therefore, the paired hardpoints are symmetrical about the X-Z plane. With symmetrical hardpoints, you only need to move one of the hardpoints, not both. If you want, however, you can break the symmetry and move only one of the hardpoints of a symmetrical pair.

   To see the symmetry, select left or right from the bottom of the Hardpoint Modification Table.
To modify the hardpoints:

1. Click the cell common to `hpl_lca_outer` and `loc_y`.
2. Change the existing value to -775. This moves the hardpoint point 25 mm outboard.
3. Scroll the table window down until you see the hardpoint `hpl_uca_outer`.
4. Click the cell common to `hpl_uca_outer` and `loc_y`.
5. Change the existing value to -700. This moves the hardpoint 25 mm outboard.
6. Select Apply.
   ADAMS/Car changes the hardpoint locations of the two hardpoints and their symmetrical right pairs.
7. Close the dialog box.

Saving the Modified Subsystem

In this section, you save the subsystem you just modified.

To save the subsystem:

1. From the File menu, point to Save, and then select Subsystem.
2. Select OK.
   Before saving the file, ADAMS/Car asks you if you want to create a backup copy of the file.
3. Select No. This overwrites the subsystem file in your default writable database.
   ADAMS/Car saves the subsystem file that you created.
Performing an Analysis on the Modified Assembly

To determine how the modifications to the suspension subsystem changed the pull on the steering wheel, you perform a pull analysis on the modified suspension and steering assembly. You can use the same loadcase file that you created in Defining a Loadcase File on page 32.

**To perform the analysis:**

1. From the Simulate menu, point to Suspension Analysis, and then select External Files.
   
   The dialog box displays the appropriate loadcase file.
2. In the Output Prefix text box, enter modified.
3. Select the Comment tool.
4. In the Comment Text text box, enter Steering axis moved 25mm outboard.
5. Select OK.
6. Select OK again.

ADAM/Car analyzes the modified suspension and steering assembly.
Comparing the Analysis Results

You now create a plot that compares the analysis results from the baseline suspension and steering assembly with the analysis results from the modified suspension and steering assembly.

To compare the analysis results:

1. From the Review menu, select Postprocessing Window.
2. From the Plot menu, select Create Plots.
3. In the Plot Configuration File text box, enter mdids://private/plot_configs.tbl/brake_pull.plt.
4. In the Plot Title text box, enter Brake Pull Analysis - UAN_FRT_SUSP.
5. To plot the results of the two analyses on one page, select Cross Plotting.
6. Select OK.
7. Use the plot navigation tools to cycle through the plots.
8. Focus on the plot of the Steering Wheel Torque vs Steering Wheel Angle, shown in Figure 10 on page 47. It contains values for both the baseline and the modified suspension and steering assembly. Notice that the pull is reduced for all steering wheel angles, as expected.
Cycle through the plots until you see a plot of the Scrub Radius vs Steering Wheel Angle, shown in Figure 11 on page 48. This plot also contains values for both the baseline and the modified suspension and steering assembly. Notice that the scrub radius decreased from 32 mm to 8 mm because of the suspension modifications.
Figure 11. Comparison Plot for Scrub Radius versus Steering Wheel Angle

Finishing Up

Before you continue with the full-vehicle tutorial in the next chapter, you should clean up your directory by deleting the plots and simulations, and closing the subsystems that you created and modified.

- Deleting Simulations, 49
- Closing Assemblies, 49
Deleting Simulations

You first delete the simulations for the baseline and modified analyses and then you return to the ADAMS/Car main window.

To delete simulations:

1. Right-click the treeview, point to Type Filter, point to Modeling, and then select Analyses.
2. To show the current simulations, double-click my_assembly.
   The treeview updates and displays the current simulations.
3. Select the simulations to delete.
4. From the Edit menu, select Delete.
   ADAMS/Car deletes the simulations.
5. From the File menu, select Close Plot Window.
   ADAMS/Car returns to the main window.

Closing Assemblies

You can now close the suspension and steering assembly.

To close the assembly:

1. From the File menu, point to Close, and then select Assembly.
   The Close Assembly dialog box appears. By default it contains the name of your assembly.
2. Select OK.
Overview

In this tutorial, you run analyses on suspension and full-vehicle assemblies to see the effects of flexible bodies.

Before you work through this tutorial, make sure you have:

- ADAMS/Flex.
- Completed the tutorial we’ve provided with ADAMS/Flex in the guide, *Using ADAMS/Flex*.
- A moderate level of finite element modeling proficiency.

This chapter includes the following sections:

- About Modal Flexibility in ADAMS/Car, 52
- What You Will Create and Analyze, 54
- Working with Flexible Bodies in Suspension Assemblies, 55
- Working with Flexible Bodies in Full-Vehicle Assemblies, 66
- Next Step, 76

This tutorial takes about one hour to complete.
About Modal Flexibility in ADAMS/Car

ADAMS/Car integrates and fully supports the ADAMS/Flex plug-in. ADAMS/Flex allows you to build flexible bodies into your templates using a modes method, called modal flexibility. It assigns a set of mode shapes (or eigenvectors) to a flexible body. The flexible body modeling element designates a system state variable to each eigenvector and calculates the relative amplitude during a time analysis. The principle of linear superposition is then used to combine the mode shapes at each time step to reproduce the total deformation of the flexible body.

The following sections further explain flexible bodies:

- About Integrating Flexible Bodies Into Templates, 52
- About Flexible Body Damping Ratio, 54

About Integrating Flexible Bodies Into Templates

Integrating flexible bodies into templates lets you capture inertial and compliance effects during handling and comfort simulations, study deformations of your flexible components, and predict loads with greater accuracy, therefore achieving more realistic results. Once the flexible body is created, ADAMS/Car displays its geometric representation in the main window.

The flexible body characteristics are defined in a finite element modeling (FEM) output file, called modal neutral file or MNF. The information in an MNF includes:

- Geometry (location of nodes and node connectivity)
- Nodal mass and inertia
- Mode shapes
- Generalized mass and stiffness for modal shapes
Getting Started Using ADAMS/Car
Flexible Bodies Tutorial

When you integrate a flexible body into a template, you have to supply the following:

- A modal neutral file. This means that the MNF should have been previously created and stored in a shared or private database.
- Location and orientation information for the part that you will create. ADAMS/Car uses the location and orientation information to rigidly rotate and translate the flexible body.
- Inertia coupling and the damping ratio.

To successfully integrate a flexible body into an ADAMS/Car template and run simulations, consider these precautions:

- Use flexible bodies if a component flexibility affects the dynamic behavior of your model or if you are interested in accurate deformations of the flexible body under various load conditions.
- Because flexible body deformations are a linear combination of deformation shapes, be careful when modeling components undergoing high nonlinear deformations.
- Consider the computational load that a flexible body representation demands, especially if the MNF description is very detailed, that is, if several modes have been included.
- Verify your flexible body and check the natural frequencies associated with the significant mode shapes and the mass and inertia properties.
About Flexible Body Damping Ratio

Dynamic system simulations are greatly complicated when the time integration must traverse a signal with very high frequency components. To achieve the desired accuracy, ADAMS/Solver must integrate the signal with a possibly prohibitively short time step. Flexible bodies can contribute large amounts of high frequency content and can, therefore, be difficult to simulate.

Carefully applying modal damping can help you successfully simulate a model containing flexible bodies. You can specify a single scalar damping value applied to all the modes, control the damping using a DMPSUB user-written subroutine, or accept the default nonzero damping that ADAMS/Flex applies to all the modes.

If you do not specify the damping, ADAMS/Flex applies the following defaults:

- 1% damping for all modes with frequency lower than 100 Hz.
- 10% damping for modes with frequency between 100 and 1000 Hz.
- 100% critical damping for modes with a frequency higher than 1000 Hz.

During simulations, ADAMS/Car displays in the Message window the type of damping that you selected for each flexible body in the model.

We suggest that in this tutorial you work with the default damping ratio.

What You Will Create and Analyze

This tutorial guides you through the following steps:

- Creating, investigating, and successfully using flexible bodies in ADAMS/Car templates.
- Importing MNFs into existing templates to create models with flexible bodies.
- Modifying flexible body properties by changing the modal contents, the inertia coupling, and the damping ratio.
- Modifying and analyzing a complete double-wishbone front suspension with flexible bodies.
- Creating a full-vehicle assembly, analyzing it, and viewing the results.
Working with Flexible Bodies in Suspension Assemblies

In this section, you create a suspension assembly containing flexible lower control arms, learn how to manage the flexible bodies in the assembly, and run an analysis and view its results. You compare the difference in longitudinal wheel displacement by changing the left lower control arm to behave as a rigid body. A flexible body behaves as a rigid body when you set the inertial invariants to rigid.

The following sections teach you how to work with flexible bodies in a suspension assembly:

- Creating a Suspension Assembly, 55
- Managing Flexible Bodies, 57
- Performing a Suspension Analysis, 62
- Animating Analysis Results, 64
- Plotting Analysis Results, 64
- Closing Suspension Assemblies, 65

Creating a Suspension Assembly

You start out by creating a double-wishbone front suspension assembly. This assembly is based on the _double_wishbone_flex template that has flexible lower control arms.

To create a suspension assembly:

1. From the File menu, point to New, and then select Suspension Assembly.
2. In the Assembly Name text box, enter susp_assy.
3. Right-click the Suspension Subsystem text box, point to Search, and then select the shared database.
4. Double-click TR_Front_Suspension_flex.sub.

Notice that by default ADAMS/Car includes a suspension test rig in the assembly.
5 Select OK.

ADAMS/Car displays the assembly (note that we turned the shading on):

**Figure 12. Double-Wishbone Suspension Assembly**
Managing Flexible Bodies
Managing flexible bodies involves verifying, modifying, and efficiently using flexible bodies. You can rigidly rotate and translate flexible bodies, reposition them relative to the rest of the subsystem, as well as change flexible body properties.

- Displaying Information About Flexible Bodies, 57
- Displaying and Animating Modes, 58
- Simplifying Geometry, 60
- Changing Flexible Body Inertia Modeling, 61

Displaying Information About Flexible Bodies
You can see if ADAMS/Car correctly imported the flexible body into the template on which the suspension subsystem is based, and display information about the properties that define the flexible body.

To display information about a flexible body:

1 Right-click the left lower control arm flexible part, point to Flexible_Body: fbl_lower_control_arm, and then select Info.

   The Information window appears as shown in Figure 13 on page 58. It lists the inertia properties, the modal contents, and the name of the MNF that ADAMS/Car used when creating the flexible body.

   The Information window also shows how many modes are active for that flexible body. Every mode has a corresponding frequency, allowing you to verify that the frequencies that ADAMS/Car displays are correct.
Displaying and Animating Modes

You can also verify flexible bodies by displaying and animating the modes, and viewing the corresponding frequencies. The Mode Manager is a powerful tool that lets you define a scale factor to emphasize the deformation of the flexible body, animate the flexible part, modify its modal content to improve the efficiency of the simulation, and set initial conditions.

The MNF, as explained in the above sections, contains information about modes and frequencies that define the flexible body.
To view and animate modes:

1. From the Adjust menu, point to Flexible Body, and then select Mode Manager.
   The Flexible Body Modify dialog box appears.

2. Right-click the Flexible Body text box, point to Flexible Body, point to Pick, and from the screen, select the left lower control arm, fbl_lower_control_arm.

3. In the Mode Number text box, enter 9, and then press Enter.
   In the Frequency text box, ADAMS/Car displays the frequency corresponding to mode 9. In the main window, note the bending of the flexible lower arm occurring at approximately 345 HZ.

4. Verify that Color Contours is set to on.
   ADAMS/Car highlights the flexible body deformation using color contours.

5. Select the Animate tool.
   ADAMS/Car animates the bending mode that the flexible body undergoes at 345 HZ.
   Leave the dialog box open, because you will use it again in the next section.
**Simplifying Geometry**

The mesh that ADAMS/Flex creates when you open a flexible body subsystem or template is based on the description of the flexible body in the MNF. The level of detail is often so high that it stretches the capabilities of your hardware. You can simplify the graphical representation by replacing the graphics of an MNF with a simple outline.

**To create an outline:**

1. Zoom in on the left lower flexible body by typing a lowercase w, holding down the left mouse button, and dragging it across the left lower flexible body. ADAMS/Car zooms in and centers the flexible body in the main window.

2. From the Flexible Body Modify dialog box, select the **Outline** tool. You use the Outline tool to trace the outline of the lower flexible body.

3. Look at Figure 14 and note the order in which you should select the outline points.

4. Click the left mouse button over Nodes 1, 3, 2, and 4, and then right-click to end the outlining operation. If you’re having trouble finding the nodes, zoom in more.

---

**Figure 14. Node Location**

N1 (select first)

N2 (select third)

N3 (select second)

N4 (select last)
5  Select **outline**, and then clear the selection of **full MNF graphics**.

ADAMS/Car toggles the flexible body mesh off and displays the outline you created. You can work through the rest of the tutorial with the left lower flexible arm in outline form.

6  Close the dialog box.

**Changing Flexible Body Inertia Modeling**

To be able to compare the suspension characteristics between the flexible right and the rigid left side, you change the inertia modeling of the left lower control arm.

ADAMS/Flex computes the time-varying mass matrix of the flexible body using nine inertia invariants. In particular, four invariant formulations have special significance.

For more information about the invariant formulations, see the guide, *Using ADAMS/Flex*.

**To change the inertia modeling:**

1  Right-click the outline of the lower control arm flexible part, point to **Flexible Body: fbl_lower_control_arm**, and then select **Modify**.

   The Modify Flexible Body dialog box appears.

2  Select the **Mode Manager** tool.

   The Flexible Body Modify dialog box appears.
3 Set Inertia modeling to Rigid body.
4 Select OK.
5 Close the Modify Flexible Body dialog box.

ADAMS/Car disables the 6th invariant, modal mass, and the flexible body becomes equivalent to a rigid part. This causes all the modes to be ignored during the simulation.

Performing a Suspension Analysis

To simulate the flexible body subsystem, you run a suspension analysis and then you review the results, focusing on the flexible body characteristics.

To perform a static load analysis on the suspension subsystem, you define upper and lower braking forces applied at the hub.
To perform a static load analysis:

1. From the **Simulate** menu, point to **Suspension Analysis**, and then select **Static Load**.
2. Fill in the dialog box as shown next, and then select **OK**.

ADAMS/Car performs the analysis and displays messages about the simulation. The static load analysis simulates the front suspension during a braking maneuver. The change in brake forces causes a longitudinal wheel displacement.
Animating Analysis Results

You animate the results of the analysis to view the deformation of the left rigid arm compared to the right flexible arm. During the animation, ADAMS/Car applies a longitudinal force at the hub.

To animate the results:

1. From the **Review** menu, select **Animation Controls**.
2. Select the **Play** tool.
   
   ADAMS/Car animates the suspension.

Plotting Analysis Results

The flexibility of the right lower control arm affects a series of suspension characteristics that ADAMS/Car computes automatically. You can review the results of these calculations in the plotting environment.

ADAMS/Car automatically loads the request file containing the suspension characteristics. Also, when a flexible body is included in a suspension or in a vehicle assembly, ADAMS/Car loads the result file produced during the analysis. The result file contains information about the flexible body, as well as any other ADAMS/Solver outputs.

To plot the results:

1. Launch ADAMS/PostProcessor just as you did in **Comparing the Analysis Results** on page 46.
2. Verify that **Source** is set to **Requests**.
3. From the **Simulation** list, select **tst1_static_load (ADAMS/Car Assembly)**.
4. From the **Request** list, select **wheel_travel_base**.
5. From the **Component** list, select **base_left**.
6. Set **Independent Axis** to **Data**.
7. From the **Request** list, select **wheel_load_longitudinal**.
8. From the **Component** list, select **braking_left**.
9 Select OK.

10 Select Add Curves.

11 Repeat Steps 4 through 10, this time selecting the right-side components for wheel_travel_base and wheel_load_longitudinal.

ADAMS/Car plots the longitudinal compliance for the left and right side versus the right longitudinal force at the contact patch.

The plot shows the effect of the flexible body on the displacement of the wheel center due to a longitudinal braking force.

Figure 15. Contact Patch Longitudinal Displacement vs. Longitudinal Force

12 Return to the ADAMS/Car main window.

Closing Suspension Assemblies

Before you continue with the full-vehicle analysis, close the suspension assembly.

To close a subsystem assembly:

1 From the File menu, point to Close, and then select Assembly.

2 Select OK.
Working with Flexible Bodies in Full-Vehicle Assemblies

In this section, you perform a full-vehicle maneuver and focus on the flexible part characteristics. Before you can perform the maneuver, you must create a full-vehicle assembly and set the suspension subsystem in kinematic mode.

You perform these operations in the following sections:

- Creating a Full-Vehicle Assembly, 66
- Defining the Kinematic Mode, 68
- Setting Up the Analysis, 68
- Performing a Full-Vehicle Analysis, 73
- Plotting Analysis Results, 74

Creating a Full-Vehicle Assembly

To create the assembly:

1. From the File menu, point to New, and then select Full-Vehicle Assembly.
2. Fill in the dialog box as shown next, and then select OK.
ADAMS/Car displays the full-vehicle assembly, as shown next:
Defining the Kinematic Mode

To eliminate the compliance contributions of the attachment bushings to the subsystem, you must set the suspension subsystem to kinematic mode. The only elastic components will be the flexible lower control arms.

To define the kinematic mode:

1. From the View menu, select Subsystem.
   The Display Subsystem dialog box appears, containing fveh_assy.TR_Front_Suspension_flex as the default subsystem.

2. Select OK.
   ADAMS/Car displays the suspension subsystem.

3. From the Adjust menu, select Kinematic Toggle.

4. Set Current Mode to Kinematic.

5. Select OK.

Setting Up the Analysis

You are now ready to submit the full-vehicle analysis. However, to become more familiar with ADAMS/Car, we recommend that you first perform the following tasks:

- Swap the MNF
- Modify the integrator parameter
- Deactivate modes

In this section you perform the following tasks:

- Swapping MNFs, 69
- Changing Modal Content, 71
Swapping MNFs

If the FEM expert produced the lower control arm modal neutral files maintaining the same node number for the attachment points, you can easily swap the flexible body (modal neutral files) and maintain the parameterization. You can replace the flexible body by selecting a different MNF provided in the shared database. This is analogous to replacing a damper or spring property file.

To swap the MNF:

1. Double-click the left flexible lower control arm, `fbl_lower_control_arm`.
   The Modify Flexible Body dialog box appears.
2. Right-click the Modal Neutral File text box, point to Search, and then select the shared database.
3. Double-click `LCA_left_tra.mnf`.
4. Select Apply.
5. Right-click the Flexible Body text box, point to Flexible Body, point to Pick, and from the screen, select the right lower control arm, `fbr_lower_control_arm`.
6. In the Modal Neutral File text box, enter `LCA_right_tra.mnf`.
7. Select OK.

ADAMS/Car replaces the flexible lower control arm that was originally modeled using shell elements in the FEM environment, with beam elements. Moreover, the lca_front hardpoint now has a different location, but ADAMS/Car has maintained the parameterization of the model, and the topological information is correct. This is because ADAMS/Car uses interface parts to connect flexible bodies with the rest of the model. Interface parts are a special class of general parts that are parameterized to the locations of the node numbers. When the locations of the node numbers move, the interface parts and the rest of the model move accordingly. Node numbers are defined in the MNF and cannot be changed in ADAMS/Car.
To return to the full-vehicle assembly, from the View menu, select Assembly.

Select OK.
Changing Modal Content

By default, when you integrate an MNF into an ADAMS/Car template, ADAMS/Flex enables all the modes that were defined during the FEM modeling except the probable rigid body modes. It is important to have the right modal content in flexible bodies, because an MNF has more modes than are needed to simulate a particular response.

To increase the efficiency of the simulations, you should disable any modes that do not contribute to the motion that your flexible part will undergo during the simulation. Be careful when disabling modes, because a disabled mode corresponds to a constraint to the part. Changing the modal content of a flexible body corresponds to a flexible body setup.

You can manually toggle modes on or off. This gives you greater flexibility and helps you avoid potential problems. You can enable and disable modes in several ways:

- Individually, based on their mode number.
- As a group, based on their mode number or frequency.
- Through a table editor. The table editor also lets you define displacement and velocity initial conditions associated with every mode.
- Based on their strain energy contribution, but you can only do this after a successful analysis. For more information on this technique, see the guide, *Using ADAMS/Flex*, or the online help.
To disable individual modes:

Some of the modes of the flexible lower control arms do not contribute effectively to the dynamic behavior of the entire system. We recommend that you disable them to reduce the computational effort and to improve the efficiency of the simulation.

You must disable these modes for both the left and the right side because a left and a right MNF defines the flexible lower control arms.

1. Zoom in on the front suspension.
2. From the Adjust menu, point to Flexible Body, and then select Mode Manager. The Flexible Body Modify dialog box appears.
3. Right-click the Flexible Body text box, point to Flexible Body, point to Pick, and from the screen, select the left lower control arm, fbl_lower_control_arm.
4. Select Modal ICs. The Modify Modal ICs dialog box appears.
5. Hold down the Shift key, select modes 28 and 29, and then select Disable Highlighted Modes.
6. Close the Modify Modal ICs dialog box.
7. Repeat Steps 3 through 6, for the right lower control arm, fbr_lower_control_arm.
8. Close the Modify Flexible Body dialog box.
Performing a Full-Vehicle Analysis

You are now ready to perform the full-vehicle analysis. After you perform the analysis, you can change the inertia modeling of the flexible body to compare the effect of the modal flexibility on the dynamics of the vehicle.

To perform the full-vehicle analysis:

1. From the Simulate menu, point to Full-Vehicle Analysis, point to Open-Loop Steering Events, and then select Step Steer.

2. Set up the analysis as follows:
   - Full-Vehicle Assembly: fveh_assy
   - Output Prefix: tst
   - End Time: 4
   - Number of Steps: 100
   - Initial Velocity: 70 (take the default of km/hr)
   - Gear Position: 3
   - Initial Steer Value: 0
   - Final Steer Value: -45
   - Step Start Time: 1
   - Duration of Step: 1
   - Steering Input: Angle

3. Select Apply, so the dialog box stays open for the analysis you will run in the next section.

The SDI test rig applies to the assembly the inputs you specified and performs a dynamic analysis.
To change the inertia modeling:

1. Double-click the left lower control arm, `fbl_lower_control_arm`.
2. Select the **Mode Manager** tool.
3. Set **Inertia modeling** to **Rigid body**.
4. Select **OK**.
5. Close the Modify Flexible Body dialog box.
6. Submit another step steer analysis using the same inputs as before, but changing the output prefix to `tst_rigid`.

ADAMS/Car analyzes the assembly.

**Plotting Analysis Results**

In this section, you create a set of plots that show the behavior of your vehicle assembly and then review how the modal flexibility of the lower control arm affects the overall dynamics of the vehicle.

To plot the results:

1. Launch ADAMS/PostProcessor.
2. From the **Plot** menu, select **Create Plots**.
3. Fill in the dialog box as shown next, and then select **OK**.
Figures 17 and 18 show some of the plots. The flexible lower control arms cause the differences between the curves.

View the plots shown next and then return to the ADAMS/Car main window.

**Figure 17. Lateral Slip Angle**

![Figure 17. Lateral Slip Angle](image1)

**Figure 18. Yaw Rate**

![Figure 18. Yaw Rate](image2)
Next Step

If you have a license of ADAMS/AutoFlex, you can continue with Tutorial for Learning ADAMS/AutoFlex with ADAMS/Car on page 45 of the guide, Using ADAMS/AutoFlex to Automatically Generate Flexible Bodies. Otherwise, continue with the Template Builder Tutorial on page 77.
Overview

This tutorial guides you through the process of building a template, creating a suspension subsystem based on the template, and then running various analyses on the subsystem. To build the template, you must use ADAMS/Car Template Builder.

This chapter includes the following sections:

- About Designing Templates, 78
- What You Will Create and Analyze, 79
- Creating Topology for Your Template, 80
- Creating a Suspension Subsystem, 114
- Analyzing an Assembly Containing Your Template, 116

This tutorial takes about two hours to complete.
About Designing Templates

ADAMS/Car templates are parametrized models in which you define the topology of vehicle components. Building a template means defining parts, how they connect to each other, and how the template communicates information to other templates and the test rig.

At the template level, it is not crucial that you correctly define the parts, assign force characteristics, and assign mass properties, because you can modify these values at the subsystem level. It is very important, however, to correctly define part connectivity and exchange of information, because you cannot modify them at the subsystem level.

When building templates, keep in mind the assembly process. That is, make sure that your templates can communicate to each other and can communicate to the test rigs you specify. In ADAMS/Car, communicators define how models communicate.

For information on creating topology, see Creating Topology for Your Template on page 80. For information on communicators, see Assembling the Model for Analysis on page 107.
What You Will Create and Analyze

To learn how to create templates, you create a complete MacPherson front suspension template, as shown in Figure 19 (note that we toggled the icon visibility off and the shading on). You then build a suspension using the template you created. Finally, you run kinematic and compliant suspension analyses and compare their results.

Figure 19. MacPherson Front Suspension Template
Creating Topology for Your Template

In ADAMS/Car, creating topology consists of creating elements, such as hardpoints, parts, attachments, and parameters that define subsystems, as explained next:

- **Creating hardpoints** - You first create hardpoints. Hardpoints are the ADAMS/Car elements that define all key locations in your model. They are the most elementary building blocks that you can use to parameterize locations and orientations for higher-level entities. Hardpoint locations define most parts and attachments. Hardpoints are only defined by their coordinate locations.

- **Creating parts** - Once you’ve defined hardpoints, you create parts and define them using the hardpoints that you created. In this tutorial, you create two types of parts: general parts, such as control arm and wheel carrier, and mount parts. General parts are rigid parts that you define using their location, orientation, mass, inertia, and center of gravity. If you want to, you can add geometry to general parts. ADAMS/Car uses either geometry-based or user-entered information to determine mass properties for general parts.

  Mount parts are massless parts that attach to other parts. For more information on mount parts, see Defining Control Arm Attachments on page 97.

- **Creating attachments** - Finally, you create the attachments, such as joints and bushings, and parameters which tell ADAMS/Car how the parts react in relation to one another. You can define attachments for the compliant and kinematic analysis modes. The compliant mode uses bushings, while the kinematic mode uses joints.

Before you begin to build your template, you must decide what elements are most appropriate for your model. You must also decide which geometries seem most applicable to each part or whether you want any geometry at all. Once you’ve decided, you create a template and create the basic topology for it. Finally, you assemble the model for analysis.
This section involves the following steps:

- Creating a Template, 81
- Building Suspension Parts, 83
- Creating and Defining Attachments and Parameters, 96
- Assembling the Model for Analysis, 107
- Finishing Up, 113

Creating a Template

You must create a template in which to build suspension parts. You should assign to your template a major role as a suspension template, because a major role defines the function the template serves for the vehicle.

To create a template:

2. From the File menu, select New.
   The New Template dialog box appears.
3. In the Template Name text box, enter macpherson.
4. Verify that Major Role is set to suspension.
5. Select OK.
   A gravity icon appears in the middle of the ADAMS/Car main window as shown in Figure 20 on page 82. If you don’t see a gravity icon, display the main pop-up menu by right-clicking the main window, and selecting Toggle Icon Visibility. You can also toggle the icon visibility on and off by putting the cursor in the main window and typing a lowercase v.
From the main pop-up menu, select **Front Iso** and **Fit - All**. Fit your model to view whenever you create an entity outside the current view.

The ADAMS/Car main window should look as follows:

**Figure 20. Main Window with Gravity Icon Displayed**
Building Suspension Parts

You create parts in ADAMS/Car through a three-step process. First, you create hardpoints that define key locations on the part. Then, you create the actual part. Finally, if you want, you add geometry to your new part.

You can use one of two methods to create parts in ADAMS/Car:

- User-entered method lets you manually enter mass properties and material type for a part.
- Geometry-based method lets you tell ADAMS/Car to automatically create mass properties using the geometry and material type that you specify.

In the next sections, you create all the parts that make up the suspension template:

- Creating the Control Arm, 84
- Creating the Wheel Carrier, 87
- Creating the Strut, 89
- Creating the Damper, 89
- Defining the Spring, 90
- Creating the Tie Rod, 92
- Creating the Hub, 94
Creating the Control Arm

The first part you define is the control arm. You begin by building its hardpoints. You can later modify these hardpoints to determine their effects on your vehicle.

Next, you create the control arm part and specify its coordinate system location and mass properties.

To complete the creation of the control arm, you create geometry for it. You then define key locations for that geometry so ADAMS/Car can calculate its mass properties. In this tutorial, whenever you want ADAMS/Car to calculate mass properties, you select steel as the material type.

When specifying orientations in ADAMS/Car, you can either enter Euler angles or specify two direction vectors. In this tutorial, you will just use Euler angles with respect to the global orientation, which is named the origo marker.

To build the hardpoints:

1. From the Build menu, point to Hardpoint, and then select New. The Create Hardpoint dialog box appears.
2. In the Hardpoint Name text box, enter arm_outer.
3. Verify that Type is set to left. In this tutorial, you set all entities to left. ADAMS/Car automatically creates a symmetrical pair about the central longitudinal axis.

   **Note:** Depending on how you set up your environment variables, the longitudinal axis can be any axis. In this tutorial, the longitudinal axis is the x-axis. For information on setting your environment variables, see Setting the Orientation of the Global Reference Frame on page 37 in the guide, Configuring Template-Based Products.

4. In the Location text box, enter 0, -700, 0.
5. Select Apply. ADAMS/Car executes the command, but leaves the Create Hardpoint dialog box open.
Repeat Steps 2 through 5 to build the two hardpoints specified in Table 2.

Table 2. Wheel Carrier Hardpoints

<table>
<thead>
<tr>
<th>Hardpoint Name</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>arm_front</td>
<td>-150, -350, 0</td>
</tr>
<tr>
<td>arm_rear</td>
<td>150, -350, 0</td>
</tr>
</tbody>
</table>

When you’re done creating the hardpoints, close the dialog box.

To see all six hardpoints in the main window, fit your model to view.

To create the control arm part:

1. From the Build menu, point to Parts, point to General Part, and then select New.
2. Fill in the dialog box as shown next, and then select OK.

ADAMS/Car creates a part coordinate system, also referred to as local part reference frame (LPRF), at the specified location, but it doesn’t create geometry.
To create the control arm geometry:

1. From the **Build** menu, point to **Geometry**, point to **Arm**, and then select **New**.

2. Create the control arm as follows:
   - **Arm Name:** control_arm
   - **General Part:** _macpherson.gel_control_arm
   - **Coordinate Reference #1:** _macpherson.ground.hpl_arm_outer
   - **Coordinate Reference #2:** _macpherson.ground.hpl_arm_front
   - **Coordinate Reference #3:** _macpherson.ground.hpl_arm_rear
   - **Thickness:** 10

3. Select **Calculate Mass Properties of General Part**.

4. Set **Density** to **Material**.

5. Select **OK**.

ADAMS/Car displays the control arm part. If you want the control arm to be shaded, put the cursor in the main window and type an uppercase S. This toggles the rendering mode between shaded and wireframe.

**Note:** Based on the geometry, the option Calculate Mass Properties of General Part computes the mass properties for the part, and adds that to the total mass of the part. (You can have more than one geometry associated with a part.)
Creating the Wheel Carrier

To create the wheel carrier, you must first create three hardpoints that define the location of the wheel carrier. You then define the wheel carrier part using these hardpoint locations.

Next, you add link geometry to the wheel carrier. When you add the link geometry, you enter parameters that are similar to those you specified for the arm geometry, except that a link only requires two coordinate reference points to define its geometry.

To create the hardpoints:

1. From the Build menu, point to Hardpoint, and then select New.
2. Create the wheel carrier hardpoints as specified in Table 3. Remember that you can select Apply to execute the command but leave the dialog box open, and select OK to execute the command and then close the dialog box.

<table>
<thead>
<tr>
<th>Hardpoint Name:</th>
<th>Location:</th>
</tr>
</thead>
<tbody>
<tr>
<td>wheel_center</td>
<td>0, -800, 100</td>
</tr>
<tr>
<td>strut_lower</td>
<td>0, -650, 250</td>
</tr>
<tr>
<td>tierod_outer</td>
<td>150, -650, 250</td>
</tr>
</tbody>
</table>

3. To display the hardpoints in the main window, toggle the icon visibility and fit your model to view.

Note: Remember that all these hardpoints are left-side hardpoints.
To create the wheel carrier part:

1. From the **Build** menu, point to **Parts**, point to **General Part**, and then select **Wizard**.
2. Create the wheel carrier part as follows:
   - **General Part Name**: wheel_carrier
   - **Geometry Type**: Arm
   - **Coordinate Reference #1**: _macpherson.ground.hpl_wheel_center
   - **Coordinate Reference #2**: _macpherson.ground.hpl_arm_outer
   - **Coordinate Reference #3**: _macpherson.ground.hpl_strut_lower
   - **Thickness**: 10
3. Select **OK**.

The wizard creates both the part and the geometry.

To add the wheel carrier link geometry:

1. From the **Build** menu, point to **Geometry**, point to **Link**, and then select **New**.
2. Create the wheel carrier part as follows:
   - **Link Name**: carrier_link
   - **General Part**: _macpherson.gel_wheel_carrier
   - **Coordinate Reference #1**: _macpherson.ground.hpl_strut_lower
   - **Coordinate Reference #2**: _macpherson.ground.hpl_tierod Outer
   - **Radius**: 10
3. Select **Calculate Mass Properties of General Part**.
4. Select **OK**.

The template now includes the wheel carrier part and the link geometry.
Creating the Strut

In this section, you create the strut part for your suspension template. Just as you did for the control arm, you enter the location, orientation, and mass properties for the strut part. Because the strut geometry would not be visible from inside the damper, you don’t need to give the strut any geometry.

To define the strut part:

1. From the Build menu, point to Parts, point to General Part, and then select New.
2. Define the strut part as follows:
   - General Part: strut
   - Location values: 0, -600, 600
   - Euler Angles: 0, 0, 0
   - Mass/Ixx/Iyy/Izz: 1
3. Select OK.

Creating the Damper

You first create a hardpoint and then use it to define the damper. You then create a damper that is defined by a property file that we provide for you. Property files define force-displacement or force-velocity characteristics for springs, dampers, bumpstops, reboundstops, and bushings. In this case, the property file defines the damper’s force-velocity curve.

To create a hardpoint:

1. Create a hardpoint as follows:
   - Hardpoint Name: strut_upper
   - Location: 0, -600, 600
2. Select OK.
To create the damper:

1. From the Build menu, point to Damper, and then select New.
2. Create the damper as follows:
   - Damper Name: damper
   - I Part: _macpherson.gel_wheel_carrier
   - J Part: _macpherson.gel strut
   - I Coordinate Reference: _macpherson.ground.hpl_strut_lower
   - J Coordinate Reference: _macpherson.ground.hpl_strut_upper
3. Select OK.

Defining the Spring

Before you define the spring, you have to create a hardpoint that defines the position of the lower spring seat. Then, to define the spring, you must specify the following:

- Two bodies between which you want the force to act.
- Specific location on each body where you want the force to act.
- Installed length of the spring, which will be used to derive the design preload on the spring.
- Property file, which contains the free length information, as well as the force/deflection characteristics.

ADAMS/Car calculates the force exerted by the spring using the following equations:

\[ C = FL - IL + DM'(i,j) \]
\[ \text{Force} = -k(C - DM(i,j)) \]

where:

- \( C \) is a constant.
- \( FL \) is the free length of the spring, as defined in the property file.
- \( IL \) is the defined installed length.
**DM**(i,j) is the initial displacement between the i and j coordinate reference points. If you enter a smaller value for **DM**(i,j), ADAMS/Car calculates an increased preload for the spring. Conversely, if you enter a larger value, ADAMS/Car calculates a decreased preload. In this tutorial, you enter the value that ADAMS/Car automatically calculates for you.

**DM**(i,j) is the change in the displacement between the i and j coordinate reference points as the simulation progresses.

**Force** represents the spring force.

**k** is the nonlinear spring stiffness derived from the property file.

**To create a hardpoint for the spring:**

1. Create a hardpoint as follows:
   - **Hardpoint Name**: spring_lower
   - **Location**: 0, -650, 300

2. Select **OK**.
To create the spring:

1. From the **Build** menu, point to **Spring**, and then select **New**.
2. Fill in the dialog box as shown next, and then select **OK**.

![Create Spring dialog box](image)

The template now includes the damper and the spring.

### Creating the Tie Rod

You first create a hardpoint and then use it to define the tie rod part.

**To create a hardpoint:**

1. Create a hardpoint with the following specifications:
   - **Hardpoint Name**: tierod_inner
   - **Location**: 200, -350, 250
2. Select **OK**.
To create the tie rod part:

1. From the Build menu, point to Parts, point to General Part, and then select Wizard.

2. Create the tie rod part as follows:
   - General Part Name: tierod
   - Geometry Type: Link
   - Coordinate Reference #1: _macpherson.ground.hpl_tierod_outer
   - Coordinate Reference #2: _macpherson.ground.hpl_tierod_inner
   - Radius: 10

3. Select OK.

   The template now includes the tie rod part.

Creating the Toe and Camber Variables

You create variables defining toe and camber angles. Because these variables are commonly used for suspension analyses, ADAMS/Car creates both of them in one step.

To create toe and camber variables:

1. From the Build menu, point to Suspension Parameters, point to Toe/Camber Values, and then select Set.

2. Fill in the dialog box as shown next, and then select OK.

   ![Set Toe & Camber Values](image)

   **Note:** When ADAMS/Car creates the toe and camber values, it also creates output communicators of the same name. For details on communicators, see Assembling the Model for Analysis on page 107.
Creating the Hub

Before you create the hub part for your template, you must create a construction frame. Construction frames are ADAMS/Car elements that you use whenever an entity requires that you specify an orientation in addition to a location.

You create the hub based on the construction frame, and then create geometry for the hub.

To create a construction frame:

1. From the Build menu, point to Construction Frame, and then select New.
2. Create a construction frame as follows:
   - Construction Frame: hub_bearing
   - Coordinate Reference: _macpherson.ground.hpl_wheel_center
   - Orientation Dependency: Toe/Camber
   - Toe Parameter Variable: _macpherson.pvl_toe_angle
   - Camber Parameter Variable: _macpherson.pvl_camber_angle
3. Select OK.

To create the hub part:

1. From the Build menu, point to Parts, point to General Part, and then select New.
2. Create the hub part as follows:
   - General Part: hub
   - Location Dependency: Delta location from coordinate
   - Coordinate Reference: cfl_hub_bearing
   - Location values: 0, 0, 0
   - Orientation Dependency: Delta orientation from coordinate
   - Construction Frame: cfl_hub_bearing
   - Orientation: 0, 0, 0
   - Mass/lxx/lxy/lzz: 1
3. Select OK.
To create cylinder geometry for the hub:

1. From the Build menu, point to Geometry, point to Cylinder, and then select New.

2. Create the cylinder geometry as follows:
   - Cylinder Name: hub
   - General Part: _macpherson.gel_hub
   - Construction Frame: _macpherson.ground.cfl_hub_bearing
   - Radius: 30
   - Length in Positive Z: 30
   - Length in Negative Z: 0
   - Color: magenta


4. Select OK.

The template now includes the hub.
Creating and Defining Attachments and Parameters

Now that you created all the ADAMS/Car parts, springs, and dampers, you are ready to define attachments and parameters.

This section includes the following:

- Defining the Translational Joint, 96
- Defining Control Arm Attachments, 97
- Defining the Strut Attachment, 101
- Defining Wheel Carrier Attachments, 103
- Defining Hub Attachments, 105
- Defining Suspension Parameters, 106

Defining the Translational Joint

You first create a translational joint between the wheel carrier and the strut. You specify that this joint is active regardless of the mode in which you simulate your model.

In ADAMS/Car, you can simulate your model in kinematic or compliant mode. A kinematic analysis uses constraints, such as translational and revolute joints, to define the attachments between the parts. During a compliant analysis, ADAMS/Car replaces these joints with bushings.

**To define a translational joint:**

1. From the Build menu, point to Attachments, point to Joint, and then select New.
2. Create the translational joint as follows:
   - Joint Name: strut_joint
   - I Part: _macpherson.gel_wheel_carrier
   - J Part: _macpherson.gel_strut
   - Joint Type: translational
   - Coordinate Reference: _macpherson.ground.hpl_strut_upper
Getting Started Using ADAMS/Car
Template Builder Tutorial

❖ Orientation Dependency: Orient axis along line
❖ Coordinate Reference #1: _macpherson.ground.hpl_strut_lower
❖ Coordinate Reference #2: _macpherson.ground.hpl_strut_upper

3 Select OK.

Defining Control Arm Attachments

Before you create bushings and joints for the control arm, you must create the mount parts that will connect to the body or subframe during assembly. A mount part is a massless part that attaches to another part. It is fixed to ground by default. Mount parts represent the vehicle body or subframe and act as place holders.

When you create a mount part, ADAMS/Car automatically creates an input communicator for it of class mount. The input communicator requests the name of the part to which the mount part should connect. If ADAMS/Car finds a matching communicator during assembly, it replaces the mount part with the part that the output communicator indicates. The replacement part is from another subsystem. If ADAMS/Car finds no matching output communicator, it replaces the mount part with the ground part.

To create a mount part, you specify a hardpoint and mount part name. If the hardpoint has a left or right symmetrical twin, ADAMS/Car creates left and right mount parts and input communicators. Otherwise, it creates a single mount part and a single input communicator.

After you create the mount parts, you create bushings for the control arm. You specify the parameters, such as preload and offset, that define bushings. In this example, you use the default values that ADAMS/Car provides. If you want, you can modify the bushing properties.

Finally, you create the control arm revolute joint. This time, you set its active status to kinematic. This tells ADAMS/Car that during a kinematic analysis it should use the revolute joint, but it should replace the joint with a bushing during a compliant analysis.
To create the mount parts:

1. From the Build menu, point to Parts, point to Mount, and then select New.
2. In the Mount Name text box, enter subframe_to_body.
3. In the Coordinate Reference text box, enter _macpherson.ground.hpl_arm_front.
4. Verify that From Minor Role is set to inherit.
5. Select OK.

ADAMS/Car creates fixed joints between the mount parts and ground. By default, the visibility of the fixed joints is turned off.
To create the front bushing for the control arm:

1. From the Build menu, point to Attachments, point to Bushing, and then select New.
2. Fill in the dialog box as shown next, and then select Apply.

ADAMS/Car creates the front bushing and leaves the dialog box open so you can create the rear bushing.
To create the rear bushing for the control arm:

1. In the **Bushing Name** text box, enter *arm_rear*.
2. In the **Coordinate Reference** text box, enter ".macpherson.ground.hpl_arm_rear*.
3. Select **OK**.

ADAMS/Car creates the rear bushing.

To create the control arm revolute joint:

1. Create the control arm revolute joint as follows:
   - **Joint Name**: *arm_front*
   - **I Part**: ".macpherson.gel_control_arm*
   - **J Part**: ".macpherson.mtl_subframe_to_body*
   - **Joint Type**: revolute
   - **Coordinate Reference**: ".macpherson.ground.hpl_arm_front*
   - **Orientation Dependency**: Orient axis along line
   - **Coordinate Reference #1**: ".macpherson.ground.hpl_arm_front*
   - **Coordinate Reference #2**: ".macpherson.ground.hpl_arm_rear*

2. Select **Apply**.

To create the control arm spherical joint:

1. Create the control arm spherical joint as follows:
   - **Joint Name**: *arm_outer*
   - **I Part**: ".macpherson.gel_wheel_carrier*
   - **J Part**: ".macpherson.gel_control_arm*
   - **Joint Type**: spherical
   - **Active**: always
   - **Coordinate Reference**: ".macpherson.ground.hpl_arm_outer*

2. Select **OK**.
Defining the Strut Attachment

Before you define the strut attachments to the vehicle body, you must define a mount part for the strut. You then create a bushing for the strut. Next, you create a spherical joint to replace the strut mount bushing during kinematic analyses.

To define a mount part:

1. Create a mount part as follows:
   - Mount Name: strut_to_body
   - Coordinate Reference: _macpherson.ground.hpl_strut_upper
   - From Minor Role: inherit

2. Select OK.
To create a bushing for the strut:

1. Create the bushing as shown next, and then select **OK**.

```
<table>
<thead>
<tr>
<th>Create Bushing Attachment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Bushing Name</td>
</tr>
<tr>
<td>L Post</td>
</tr>
<tr>
<td>J Post</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Inactive</td>
</tr>
<tr>
<td>Perked</td>
</tr>
<tr>
<td>Thrust</td>
</tr>
<tr>
<td>Diffuse</td>
</tr>
<tr>
<td>Initial</td>
</tr>
<tr>
<td>Diameter length</td>
</tr>
<tr>
<td>Diameter Radius</td>
</tr>
<tr>
<td>Property File</td>
</tr>
<tr>
<td>Location Dependence</td>
</tr>
<tr>
<td>Coordinate Reference</td>
</tr>
<tr>
<td>Location</td>
</tr>
<tr>
<td>Location in</td>
</tr>
<tr>
<td>Orientation Dependence</td>
</tr>
<tr>
<td>Origin using</td>
</tr>
<tr>
<td>Euler Angles</td>
</tr>
<tr>
<td>Z Vector</td>
</tr>
</tbody>
</table>
```

**ADAMS**
To create a spherical joint for the strut:

1. Create the spherical joint as follows:
   - Joint Name: strut_upper
   - I Part: _macpherson.gel_strut
   - J Part: _macpherson.mtl_strut_to_body
   - Joint Type: spherical
   - Active: kinematic mode
   - Coordinate Reference: _macpherson.ground.hpl_strut_upper

2. Select Apply.

Defining Wheel Carrier Attachments

In this section, you define a spherical joint between the wheel carrier and the tie rod. You then define the mount part that connects the suspension to the steering rack during assembly. Finally, you create a hooke joint between the tie rod and the steering rack.

To create a spherical joint:

1. Create the spherical joint as follows:
   - Joint Name: tierod_outer
   - I Part: _macpherson.gel_wheel_carrier
   - J Part: _macpherson.gel_tierod
   - Joint Type: spherical
   - Active: always
   - Coordinate Reference: _macpherson.ground.hpl_tierod_outer

2. Select OK.
To create a mount part for the hooke joint:

1. Create a mount part as follows:
   - **Mount Name**: tierod_to_steering
   - **Coordinate Reference**: _macpherson.ground.hpl_tierod_inner
   - **From Minor Role**: inherit

2. Select OK.

To create a hooke joint:

1. Create a hooke joint as follows:
   - **Joint Name**: tierod_inner
   - **I Part**: _macpherson.gel_tierod
   - **J Part**: _macpherson.mtl_tierod_to_steering
   - **Joint Type**: hooke
   - **Active**: always
   - **Coordinate Reference**: _macpherson.ground.hpl_tierod_inner
   - **I-Part Axis**: _macpherson.ground.hpl_tierod_outer
   - **J-Part Axis**: _macpherson.ground.hpr_tierod_inner

2. Select Apply.

Note the symmetry differences.
Defining Hub Attachments
You can now define the hub bearing revolute joint between the wheel carrier and the hub.

To define the hub attachment:

1. Create a revolute joint as follows:
   - Joint Name: hub_bearing
   - I Part: _macpherson.gel_wheel_carrier
   - J Part: _macpherson.gel_hub
   - Joint Type: revolute
   - Active: always
   - Coordinate Reference: _macpherson.ground.hpl_wheel_center
   - Orientation Dependency: Delta orientation from coordinate
   - Construction Frame: _macpherson.ground.cfl_hub_bearing

2. Select OK.
Defining Suspension Parameters

You create a steering axis using the geometric method for calculating steer axes. When using the geometric method, ADAMS/Car calculates the steer axis by passing a line through two non-coincident hardpoints located on the steer axis. To use the geometric method, you must identify the part(s) and two hardpoints that fix the steer axis.

To create a steering axis:

1. From the Build menu, point to Suspension Parameters, point to Characteristic Array, and then select Set.

2. Fill in the dialog box as shown next, and then select OK.
Assembling the Model for Analysis

ADAMS/Car uses communicators to correctly assemble the model for analysis. Communicators are the ADAMS/Car elements that allow the subsystems and test rigs to exchange information about the following:

- Topological data, meaning information about parts and attachments.
- Array and parameter variables.
- Locations, orientations, and so on.

Every subsystem or test rig in ADAMS/Car has input communicators that need information from other subsystems to function correctly in the model. Similarly, the corresponding subsystem or test rig, needs to have a correctly named output communicator that will send it information. For example, an input communicator needs information on the location of a hardpoint. A corresponding output communicator provides the location information.

During the assembly process, ADAMS/Car scans the model for subsystems with minor roles. It then looks through those subsystems for any input communicators that require information. It then tries to find an output communicator, of the same entity type, with the same matching name. If it can’t find one, it won’t match the communicators and the model may be incorrectly assembled.

For example, whenever you create a mount part in your template, ADAMS/Car automatically creates a corresponding input communicator. During assembly, this input communicator should match the correct output mount communicator located in the test rig. If ADAMS/Car finds no matching output communicator, it replaces the mount part with the ground part.

ADAMS/Car automatically creates an input communicator corresponding to that mount on the test rig. Then, you need to create a matching output communicator on the template you are creating. These communicators must have the exact same name for ADAMS/Car to know which communicators to use. This is explained in detail in Defining Communicators on page 108.

In this section, you create and verify output communicators:

- Defining Communicators, 108
- Testing Communicators, 111
Defining Communicators

For the assembly process to work correctly, you must define how the suspension is to connect to the suspension test rig (_MDI_SUSPENSION_TESTRIG). To do this, you define the communicators that attach the hub to the suspension test rig at the wheel center, as follows:

- To tell the suspension test rig to which part it needs to be connected, you define an output communicator of type mount. This communicator accomplishes two tasks:
  - Communicates the part to which the testrig is being connected.
  - Defines the I part of the static lock actuator.
- To tell the suspension test rig where the connection takes place, you define an output communicator of type location.
- To tell the suspension testrig which is the upright part (wheel carrier), to create a static lock actuator, you define an output communicator of type mount. This communicators defines the J part of the static lock actuator.

When you analyze the suspension in static mode, you must lock the hub to the wheel carrier. If you don’t lock the hub to the wheel carrier, your assembly will have a rotational degree of freedom that prevents the analysis from converging to a solution. ADAMS/Car creates the actuator between the hub and the upright (wheel carrier), automatically based on the communicators mentioned above.

To display information about communicators:

1. From the Build menu, point to Communicator, and then select Info.
2. Clear the Model Names text box.
3. Right-click the Model Names text box, point to Model, point to Guesses, and then select _MDI_SUSPENSION_TESTRIG.
4. Select array, location, and mount.
5. Select OK.
The Information window appears as shown next:

The Information window lists the mount input communicators. Notice that ADAMS/Car automatically adds the prefix ci[l/r] (which designates communicator input left or right) to the name of input communicators. If you want to see the entire contents of the Information window, use the vertical scroll bar. If you want to see the matching name for each communicator, use the horizontal scroll bar.

6 Select Close.

To create the output communicators:

1 From the Build menu, point to Communicator, point to Output, and then select New.
2 In the Output Communicator Name text box, enter suspension_mount.
3 Set Entity to mount.
4 Verify that To Minor Role is set to inherit.
In the **Part Name** text box, enter `_macpherson.gel_hub`.

**Note:** ADAMS/Car allows you to specify one or more Matching Names so that you can designate different communicators for the front and rear subsystems in case you might be using the same template for both subsystems. In this case, you’ll just leave it blank since ADAMS/Car defaults to assigning the communicator name as the matching name if none is specified.

6 Select **Apply**.

ADAMS/Car selects the hub as the part to which the test rig connects.

7 In the **Output Communicator Name** text box, enter `suspension_upright`.

8 In the **Part Name** text box, enter `_macpherson.gel_wheel_carrier`.

9 Select **Apply**.

10 In the **Output Communicator Name** text box, enter `wheel_center`.

11 Set **Entity to location**.

12 Verify that **To Minor Role** is set to `inherit`.

13 In the **Coordinate Reference Name** text box, enter `_macpherson.ground.hpl_wheel_center`.

14 Select **OK**.

ADAMS/Car will use this location communicator to select the location on the hub to which the test rig connects.
Testing Communicators

To verify that you correctly specified the input and output communicators, you can test communication in your template. Testing your communicators lets you find out whether to add or modify communicators to ensure that your suspension template will assemble properly with the suspension test rig.

To test the communicators:

1. From the Build menu, point to Communicator, and then select Test.
2. Fill in the dialog box as shown next, and then select OK.
The Information window appears as shown next:

![Information Window Screenshot]

The Information window lists which communicators are matched, and which are not. First, it shows you the matched communicators that are correctly sending and receiving information between subsystems and test rigs. Notice that the mount communicators for `suspension_mount`, `suspension_upright`, and `wheel_center` are listed in the matched communicator section.

The Information window also lists input and output communicators that are not matched correctly. Many communicators are unmatched. Many of these communicators are related to items such as the steering or chassis that we do not currently have open. When you start creating your own templates, you can use the Information window to verify that you included all necessary communicators.

3 Select Close.
Finishing Up

After you finish building the template, save it in your private database so you can use it later to create suspension subsystems. ADAMS/Car assigns the extension .tpl to your template.

After you save your template, you can exit template-builder mode and start the ADAMS/Car Standard Interface.

To save the suspension template:

1. From the File menu, select Save.
2. Verify that Template Name is set to _macpherson.
3. Select OK.

To exit template-builder mode:

- From the Tools menu, select ADAMS/Car Standard Interface.

ADAMS/Car returns to standard-interface mode, where you can create the suspension subsystem.
Creating a Suspension Subsystem

In this section, you create an ADAMS/Car suspension subsystem that is based on the template you just built. You also modify some hardpoints and translate the subsystem to ensure that ADAMS/Car correctly positions the subsystem within the assembly.

To create a subsystem:

1. From the File menu, point to New, and then select Subsystem.
2. Fill in the dialog box as shown next, and then select OK.

ADAMS/Car displays the following message:
The template _macpherson exists in memory. Do you want to use it?

3. Select Yes.

ADAMS/Car displays the subsystem.
To modify hardpoints:

1. From the Adjust menu, point to Hardpoint, and then select Table.
2. Modify the hardpoint values to match those listed in Table 4:

<table>
<thead>
<tr>
<th>Name:</th>
<th>loc_x:</th>
<th>loc_y:</th>
<th>loc_z:</th>
</tr>
</thead>
<tbody>
<tr>
<td>hpl_arm_front</td>
<td>-200</td>
<td>-400</td>
<td>225</td>
</tr>
<tr>
<td>hpl_arm_rear</td>
<td>200</td>
<td>-390</td>
<td>240</td>
</tr>
<tr>
<td>hpl_tierod_inner</td>
<td>200</td>
<td>-400</td>
<td>300</td>
</tr>
<tr>
<td>hpl_tierod_outer</td>
<td>150</td>
<td>-690</td>
<td>300</td>
</tr>
</tbody>
</table>

3. Select Apply.
4. Select Cancel.

To save the subsystem:

1. From the File menu, point to Save, and then select Subsystem.
2. Verify that Subsystem Name is set to my_macpherson.
3. Select OK.
Analyzing an Assembly Containing Your Template

In this section, you perform two types of suspension analyses and plot the results. We assume that you already completed the previous tutorials, and know how to incorporate your new template into an analysis.

You perform the following types of analyses:

- Performing a Kinematic Analysis, 116
- Performing an Elasto-Kinematic Analysis, 120

Performing a Kinematic Analysis

When you perform a kinematic analysis, you use the joints, rather than the bushings, that you defined when you built your template.

Before you can perform the kinematic analysis, you must create a suspension assembly. After you create the suspension assembly, define a preload.

To create a suspension assembly:

1. From the File menu, point to New, and then select Suspension Assembly.
2. In the Assembly Name text box, enter susp_assy_1.
3. Verify that Suspension Subsystem is set to the name of your subsystem, my_macpherson. If it is not, click the folder icon next to Suspension Subsystem. The name of your subsystem, my_macpherson, appears next to the icon.
4. Select OK.
5. When ADAMS/Car finishes creating the assembly, select Close.
To define a preload:

1. Right-click either spring, point to the name of the spring, and then select Modify.
2. Set Installed Length to 135.0.
3. Select OK.

To change to kinematic mode:

1. From the Adjust menu, select Kinematic Toggle. The Subsystem text box should already contain the name of your subsystem.
2. Set Current Mode to Kinematic.
3. Select OK.

To perform a kinematic suspension analysis:

1. From the Simulate menu, point to Suspension Analysis, and then select Parallel Wheel Travel.
2. Fill in the dialog box as shown next, and then select OK.

ADAMS/Car performs the analysis and displays messages about the simulation.

3. When the analysis is complete, select Close.
To animate the results:

1. From the Review menu, select Animation Controls.
2. Select the Play tool.
   The suspension animates through full jounce and rebound.

To plot the results:

1. Launch ADAMS/PostProcessor just as you did in Plotting the Results on page 29.
2. From the Plot menu, select Create Plots.
3. Set up the plots as follows:
   - Plot Configuration File: mdids://shared/plot_configs.tbl/mdi_suspension_parallel_travel.plt
   - Plot Title: My MacPherson
4. Verify that Cross Plotting is not selected.
5. Select OK.
   ADAMS/Car automatically generates a series of plots based on this plot configuration file.
6 Cycle through the plots using the plot navigation tools. Figure 21 shows the Toe Angle plot.

**Figure 21. Plot of Toe Angle - Kinematic Analysis**

7 After viewing the plots, return to the ADAMS/Car main window.
Performing an Elasto-Kinematic Analysis

To run an elasto-kinematic analysis, you must first switch the mode from kinematic to compliant. This turns off kinematic constraints and uses bushings for attachments between the parts.

Next, you must modify analysis parameters, and then run the analysis.

After the analysis is complete, you return to the ADAMS Plotting window to compare analysis results.

To change to compliant mode:

1. From the Adjust menu, select Kinematic Toggle.
2. Set Current Mode to Compliant.
3. Select OK.

To perform an elasto-kinematic analysis:

1. From the Simulate menu, point to Suspension Analysis, and then select Parallel Wheel Travel.
2. Set the Output Prefix to ela.
3. Select OK.

ADAMS/Car performs the analysis and displays messages about the simulation.

To plot the results of the elasto-kinematic analysis:

1. In ADAMS/PostProcessor, set up the comparison plots as follows:
   - Plot Configuration File: mdids://shared/plot_configs.tbl/mds_suspension_parallel_travel.plt
   - Plot Title: My MacPherson
2. Select Cross Plotting.
3. Select OK.

ADAMS/Car creates plots with both analyses results included on each plot.
Figure 22 shows a comparison plot for the toe angle.

**Figure 22. Toe Angle - Comparison Plot**

Note that the elastic toe angle is greater than the toe angle as measured in kinematic mode.
Overview

This tutorial teaches you how to create a full-vehicle assembly, run different types of analyses, and view the results.

To be able to run through this tutorial, you must have purchased the ADAMS/Car Vehicle Dynamics Package.

This chapter includes the following sections:

- What You Will Create and Analyze, 124
- Opening a Full-Vehicle Assembly, 125
- Performing a Single Lane-Change Analysis, 126
- Performing a Quasi-Static Steady-State Cornering (SSC) Analysis, 132
- Performing a Baseline ISO Lane-Change Analysis, 135
- Next Step, 146

This tutorial takes about one hour to complete.
What You Will Create and Analyze

In this tutorial, you run several analyses on a full-vehicle assembly, as shown in Figure 23, and then view the results using animation and plotting. To perform the analyses, you create an assembly containing all the subsystems in the full vehicle.

Figure 23 shows the full-vehicle assembly (front iso view, fit to view, and shaded).

Figure 23. Full-Vehicle Assembly
After you create the full-vehicle assembly, you do the following:

- To quantify how the vehicle responds to steering inputs, you perform a single lane-change (open-loop) analysis on the vehicle. A single lane-change analysis controls the steering subsystem and simulates a simple lane-change maneuver with the set of parameters you enter when you submit the analysis.
- To evaluate the vehicle’s understeer and oversteer characteristics, you run a constant radius cornering analysis.
- To drive the vehicle through a lane-change course as described in ISO-3888, you run an ISO lane-change analysis.
- After you run each analysis, you animate and plot its results.

Opening a Full-Vehicle Assembly

Using ADAMS/Car, you can group separate subsystems and test rigs into an assembly. This grouping simplifies the opening and saving of subsystems.

In this section, you open an assembly that contains the subsystems for the full vehicle that you are going to analyze. The assembly we’ve provided for you contains various subsystems that ADAMS/Car requires to perform steering maneuvers, acceleration maneuvers, and so on. Full-vehicle assemblies contain the following:

- Front and rear suspension
- Steering subsystem
- Powertrain
- Brake subsystem
- Front/rear tires
- Rigid chassis

By default, ADAMS/Car includes a vehicle test rig in the assembly.
To open an assembly:

1. From the File menu, point to Open, and then select Assembly.
2. Right-click the Assembly Name text box, point to Search, and then select the shared database.
4. Select OK.
   The Message window appears, informing you that ADAMS/Car is opening the assembly.
5. When ADAMS/Car is done loading the assembly, select Close.
   ADAMS/Car displays the full-vehicle assembly, as shown in Figure 23 on page 124.

Performing a Single Lane-Change Analysis

Now that you opened a full-vehicle assembly, you can submit a single lane-change analysis.
Performing a single lane-change analysis involves the following:

- Setting Up the Analysis, 127
- Animating the Results, 128
- Plotting the Results, 130
- Modifying Plot Layouts, 132
Setting Up the Analysis

You can now specify the inputs for the full-vehicle analysis and perform a single lane-change maneuver. A single lane-change maneuver indicates that the steering input goes through a complete sine cycle in the amount of time you specify as the maximum steer value parameter.

To set up the analysis:

1. From the Simulate menu, point to Full-Vehicle Analysis, point to Open-Loop Steering Events, and then select Single Lane Change.

2. Fill in the dialog box as shown next, and then select OK.

![Full-Vehicle Analysis: Single Lane Change dialog box]

Represent the duration and the resolution of the analysis
ADAMS/Car updates the force entities, such as dampers, springs, and bushings, with the values specified in their property files and sets up the vehicle assembly for the maneuver. Setting up the vehicle assembly includes deactivating certain motions and forces, depending on the type of steering input you selected and the inputs you specified. For example, because you set the steering input to angle, ADAMS/Car deactivates the torque on the steering wheel and the force on the rack, and activates a motion on the steering wheel revolute joint.

The SDI test rig, which is part of the assembly, applies the inputs you specified in the analysis submission dialog box to the assembly, and performs a dynamic analysis.

3 When the analysis is complete, select Close.

You are now ready to animate and plot the results.

### Animating the Results

In this section, you view the analysis you just ran. ADAMS/Car has already loaded the animation or the graphic files for you.

Before you animate, you might want to change the magnification of your assembly so you can see the path the vehicle is taking.

**To change the magnification of your assembly:**

1 When the cursor is in the center of the main window, type a lowercase **z**.

2 Hold down the left mouse button, and do either of the following:
   - To enlarge the display of the assembly, or zoom in, move the cursor up.
   - To shrink the display of the assembly, or zoom out, move the cursor down.

3 To exit zoom mode, release the mouse button.

4 Animate the results just as you did in Animating the Results on page 28.
5 If you want the vehicle to always be in the center of the screen, do the following:
   ❖ Toggle Fixed Base to Base Part.
   ❖ Right-click the text box under Base Part, point to Body, and then select Browse.
      The Database Navigator appears.
   ❖ From the list under MDI_Demo_Vehicle, double-click TR_Body, and then double-click ges_chassis.

6 If you want to see the path the vehicle takes, do the following:
   ❖ Toggle No Trace to Trace Marker.
   ❖ Right-click the text box under Trace Marker, point to Marker, and then select Browse.
      The Database Navigator appears.
   ❖ Double-click TR_BODY.
   ❖ Double-click ges_chassis.
   ❖ Double-click cm.

7 To run another animation with either of the options presented in Steps 5 or 6, select the Play tool.
   ADAMS/Car animates the vehicle.

8 To return the assembly to its initial configuration, select the Reset tool.
Plotting the Results

In this section, you create two plots that represent the following:

- Vehicle lateral acceleration as a function of time
- Roll angle of the vehicle as a function of the lateral acceleration

To create a plot of the lateral acceleration with respect to time:

1. From the Review menu, select Postprocessing Window.
2. Verify that Source is set to Requests.
3. From the Simulation list, select fveh_test_sin (ADAMS/Car Assembly).
4. From the Filter list, select user defined.
5. From the Request list, select chassis_accelerations. You might have to scroll to see this option.
6. From the Component list, select lateral.
7. Set the Independent Axis to Time.
8. Select Add Curves.

ADAMS/PostProcessor displays the plot you requested, as shown next:

![Figure 24. Plot of Lateral Acceleration versus Time](image)

Note: Although the y-axis shows NO UNITS, acceleration is expressed in Gs.
To create a plot of the roll angle with respect to lateral acceleration:

1. From the Request list, select **chassis_displacements**.
2. From the Component list, select **roll**.
3. Set the Independent Axis to **Data**.
   The Independent Axis Browser appears. You perform the next four steps in the browser.
4. From the Filter list, select **user defined**.
5. From the Request list, select **chassis_accelerations**. You might have to scroll to see this option.
6. From the Component list, select **lateral**.
7. Select **OK**.
8. From the dashboard, select **Clear Plot**.
9. Select **Add Curves**.
   ADAMS/PostProcessor displays the plot you requested, as shown next:

   **Figure 25. Plot of Roll Angle versus Lateral Acceleration**
Modifying Plot Layouts

To make a plot ready for a report, you can assign a title or subtitle to the plot, just as you did in Plotting Steering Wheel Torque versus Steering Wheel Angle on page 36.

**To assign a title or subtitle:**

1. Assign the following title to your plot: *Roll Angle versus Lateral Acceleration*.
2. Assign the following subtitle to your plot: *plot1*.
3. Return to the ADAMS/Car main window.

Performing a Quasi-Static Steady-State Cornering (SSC) Analysis

You use an SSC analysis to evaluate your full vehicle’s understeer and oversteer characteristics. The SSC analysis holds the turn radius constant and varies the vehicle velocity to produce increasing amounts of lateral acceleration. A control subroutine, CONSUB, controls the analysis and balances all the forces on the body and applies a lateral acceleration to all model parts.

Submit an SSC analysis and view the results as explained in the following sections:

- Setting Up the Analysis, 133
- Animating and Plotting the Results, 134
Setting Up the Analysis

You can now specify the inputs for the full-vehicle analysis and perform a quasi-static maneuver.

To set up the analysis:

1. From the **Simulate** menu, point to **Full-Vehicle Analysis**, point to **Quasi-Static Maneuvers**, and then select **Constant Radius Cornering**.

2. Run an analysis with the following specifications:
   - Output Prefix: ssc1
   - Number of Steps: 30
   - Final Lateral Accel: .9
   - Turn Radius: 50
   - Set the units option menu for the turn radius to m.

3. Select **OK**.

ADAMS/Car updates the properties of force entities such as dampers, springs, and bushings, with the values specified in their property files and sets up the vehicle assembly for the maneuver.

The number of steps for the output is directly related to the acceleration increment (that is, acceleration increment = final lateral acceleration / number of steps).

ADAMS/Car performs a static analysis at each lateral acceleration increment. When the vehicle reaches the specified final lateral acceleration, the maneuver ends automatically.
Animating and Plotting the Results

In this section, you view the results of the analysis you just ran. ADAMS/Car has already loaded the animation or the graphic files for you. Before you animate, you should change the magnification of your assembly so you can see the path the vehicle is taking.

After you animate, create plots using a plot configuration file (.plt), as explained next.

To create plots associated with the maneuver:

1. From the Review menu, select Postprocessing Window.
2. From the Plot menu, select Create Plots.
3. Right-click the Plot Configuration File text box, point to Search, and then select the shared database.
5. Select OK.

You have automatically created a series of plots associated with this type of maneuver. ADAMS/PostProcessor displays the first plot, as shown next:

Figure 26. Plot of Steering Angle versus Lateral Acceleration
To view the rest of the plots, select them from the treeview. For example, to view the second plot, select `page_plot_2`.

ADAMS/Car displays a plot of the chassis roll angle versus lateral acceleration.

Return to the ADAMS/Car main window.

**Performing a Baseline ISO Lane-Change Analysis**

You now perform a baseline ISO lane-change analysis on the new assembly and then plot and view the results. You then modify the spring and analyze the assembly again.

In an ISO lane-change analysis, the Driving Machine drives your full vehicle through a lane-change course as described in ISO-3888: Double Lane Change. You specify the gear position and the desired speed at which to perform the lane change. The analysis stops after the vehicle travels 250 meters; therefore, the time to complete the return maneuver depends on the speed that you input.

The following sections explain how to perform a baseline ISO lane-change analysis:

- Setting Up the Analysis, 136
- Animating and Plotting the Results, 140
- Saving the Plot Configuration, 142
- Modifying the Full-Vehicle Assembly, 143
- Performing an Analysis on the Modified Full-Vehicle Assembly, 144
- Comparing Analysis Results, 145
Setting Up the Analysis

You can now specify the inputs for the full-vehicle analysis and perform an ISO lane-change maneuver. Note that the analysis is event-based, so its duration depends on the dynamic of the vehicle and on the length of the course.

To set up the analysis:

1. From the Simulate menu, point to Full-Vehicle Analysis, point to Course Events, and then select ISO Lane Change.

2. Set up the analysis with the following characteristics:
   - Output Prefix: iso1
   - Initial Velocity: 100
   - Gear Position: 3

3. Select OK.

ADAMS/Car updates the properties of force entities such as dampers, springs, and bushings, with the values specified in their property files and then sets up the vehicle assembly for the maneuver. When you submit the analysis, ADAMS/Car automatically generates a driver control file (.dcf). The name of the .dcf file follows the same naming convention as the other files that ADAMS/Car generates.

The SDI test rig, which is part of the assembly, applies the inputs you specified in the .dcf file to the assembly, and performs a dynamic analysis.

For information on the Driving Machine and .def files, see the guide, Running Analyses in ADAMS/Car.
ADAMS/Car generates a .dcf file for this ISO lane-change maneuver, as shown next:

```
$----------------------------------------MDI_HEADER
[MDI_HEADER]
FILE_TYPE = 'dcf'
FILE_VERSION = 2.0
FILE_FORMAT = 'ASCII'
(COMMENTS)
(comment_string)
'DCF file for Closed Loop ISO-Lane Change'
$----------------------------------------UNITS
[UNITS]
LENGTH  =  'mm'
FORCE   =  'newton'
ANGLE   =  'deg'
MASS    =  'kg'
TIME    =  'sec'
$----------------------------------------EXPERIMENT
[EXPERIMENT]
EXPERIMENT_NAME = 'ISO-Lane Change'
STATIC_SETUP = 'STRAIGHT'
INITIAL_SPEED = 27777.78
INITIAL_GEAR = 3

(MINI_MANEUVERS)
(mini_manuever   abort_time   step_size)
'LANE_CHANGE' 10.80    0.05
```
Getting Started Using ADAMS/Car
Full-Vehicle Analysis Tutorial

$LANE\_CHANGE$

[LANE\_CHANGE]
(STEERING)
ACTUATOR\_TYPE = 'ROTATION'
METHOD = 'MACHINE'

(THROTTLE)
METHOD = 'MACHINE'

(BRAKING)
METHOD = 'MACHINE'

(GEAR)
METHOD = 'OPEN'
MODE = 'ABSOLUTE'
CONTROL\_TYPE = 'CONSTANT'
CONTROL\_VALUE = 3

(CLUTCH)
METHOD = 'OPEN'
MODE = 'ABSOLUTE'
CONTROL\_TYPE = 'CONSTANT'
CONTROL\_VALUE = 0

(MACHINE\CONTROL)
STEERING\CONTROL = 'FILE'
DCD\_FILE = 'iso\_lane\_change.dcd'

SPEED\CONTROL = 'MAINTAIN'

MIN\ENGINE\_SPEED = 1000.00
MAX\ENGINE\_SPEED = 7000.00

(END\_CONDITIONS)

(measure test value allowed_error filter\_time delay\_time group)
'DISTANCE' '==' 250000.00 500.0 0.0 0.0

The path description of the ISO lane-change course is referenced in the MACHINE\CONTROL block of ISO lane change of the .def file. This information is stored in a driver control data (.dcd) file, as shown next:

[MDI\_HEADER]
FILE\NAME = iso\_lane\_change.dcd
FILE\TYPE = 'dcd'
FILE\VERSION = 1.0
FILE\FORMAT = 'ASCII'

(COMMENTS)

'Example DCD file of ISO-Lane Change Path'
$--------------------------------------------------------------------------

[UNITS]
LENGTH = 'meters'
FORCE  = 'newton'
ANGLE  = 'radians'
MASS   = 'kg'
TIME   = 'sec'

$--------------------------------------------------------------------------

[CLOSED_LOOP]
STEERING_CONTROL = 'path'
SPEED_CONTROL    = 'none'

(DATA)
{ X    Y }
0.0  0.000
45.0 0.000
52.5 0.000
60.0 0.000
90.0 3.586
102.0 3.586
115.0 3.586
140.0 0.172
147.0 0.172
155.0 0.172
162.0 0.172
170.0 0.172
200.0 0.172
300.0 0.172
400.0 0.172
500.0 0.172

For information on .dcd files, see the guide, Running Analyses in ADAMS/Car.
Animating and Plotting the Results

ADAMS/Car has already loaded the animation or the graphic files for you, so you can now view the results of the analysis you just ran. Before you animate, you should change the magnification of your assembly so you can see the path the vehicle is taking.

After you animate, create two plots to represent the following:

- Vehicle lateral acceleration versus time
- Roll angle of the vehicle versus the lateral acceleration

To create a plot of the lateral acceleration versus time:

1. Launch ADAMS/PostProcessor.
2. Select Clear Plot.
3. Verify that Source is set to Requests.
4. From the Simulation list, select iso1_ilc (ADAMS/Car Assembly).
5. From the Filter list, select user defined.
6. From the Request list, select chassis_accelerations.
7. From the Component list, select lateral.
8. Set the Independent Axis to Time.
9 Select **Add Curves**.

ADAMS/PostProcessor displays the plot you requested, as shown next:

![Figure 27. Plot of Lateral Acceleration versus Time](image)

To create a plot of the roll angle with respect to lateral acceleration:

1 Select **Clear Plot**.
2 From the **Request** list, select **chassis_displacements**.
3 From the **Component** list, select **roll**.
4 Set the **Independent Axis** to **Data**.
   The Independent Axis Browser appears. You perform the next four steps in the browser.
5 From the **Filter** list, select **user defined**.
6 From the **Request** list, select **chassis_accelerations**.
7 From the **Component** list, select **lateral**.
8 Select **OK**.
Select **Add Curves**.

ADAMS/PostProcessor displays the plot you requested, as shown next:

**Figure 28. Plot of Roll Angle versus Lateral Acceleration**

---

**Saving the Plot Configuration**

Saving the plot configuration allows you to easily recreate the plots later in this tutorial after you modify the full-vehicle assembly.

**To save the plot configuration:**

1. From the **File** menu, point to **Export**, and then select **Plot Configuration File**.
2. In the **Configuration File Name** text box, enter `iso_lane_change`.
3. Make sure **All Plots** is selected.
4. Select **OK**.
5. Return to the ADAMS/Car main window.
Modifying the Full-Vehicle Assembly

To change the roll angle versus lateral acceleration vehicle characteristic, modify the spring by creating and assigning a new property file.

After you create a spring property file, assign the newly created property file to the front and rear springs.

To create a new spring property file:

1. From the Tools menu, select Curve Manager.
2. From the File menu, select New.
3. Verify that Type is set to spring.
4. Select OK.
   
   ADAMS/Car generates a plot of the spring displacement versus force characteristic in the plot window of the Curve Manager.
5. In the Slope text box, enter 225.
6. Make sure the extension/compressions limits are set to -100, 100.
7. Select Apply.
   
   ADAMS/Car modifies the spring characteristic.
8. In the Free Length text box, enter 300.
9. Select Apply.
10. From the File menu, select Save.
11. In the File text box, enter my_spring.
12. Select OK.
13. Close the Curve Manager.

   ADAMS/Car returns to the main window.
To modify the springs:

1. In the model, right-click the front spring, ns[ir]_ride_spring, and then select **Modify**.
   The Modify Spring dialog box loads the spring parameters in the text boxes.

2. Right-click the **Property File** text box and, from your default writable database, select **my_spring.spr**.

3. Replace **Installed Length** with **Preload**.

4. Enter a **Preload** of 5500.

5. Select **Apply**.
   ADAMS/Car assigns the new property file to the spring.

6. Repeat Steps 1 through 4 for the rear springs.

7. Select **OK**.

Performing an Analysis on the Modified Full-Vehicle Assembly

To determine how the modifications to the suspension subsystem affected the behavior of the vehicle, perform another single lane-change analysis.

To perform the analysis:

1. From the **Simulate** menu, point to **Full-Vehicle Analysis**, point to **Course Events**, and then select **ISO Lane Change**.

2. In the **Output Prefix** text box, enter **iso2**.

3. Select **OK**.
Comparing Analysis Results

You now create a plot to compare the analysis results from the baseline vehicle assembly with the analysis results from the modified vehicle assembly.

In addition to the plots defined in the plotting configuration file, you will review the vehicle velocity. The Driving Machine longitudinal controller acts on the throttle demand to maintain the vehicle at the desired speed.

To compare the analysis results:

1. Launch ADAMS/PostProcessor.
2. From the Plot menu, select Create Plots.
3. In the Analyses text box, enter the iso1.ilc and iso2.ilc analyses.
4. In the Plot Configuration File text box, browse for iso_lane_change.plt.
5. Select Cross Plotting.
6. Select OK.

ADAMS/PostProcessor displays a plot of the roll angle versus lateral acceleration.

The new spring property file has a linear stiffness of 225 N/mm versus the 125 N/mm of the original spring files. A stiffer spring reduces the roll angle of the vehicle, effectively modifying the handling behavior and the ride comfort of the vehicle.

To create a plot of the longitudinal velocity versus time:

1. Select the New Page tool.
2. From the Request list, select chassis_velocities.
3. From the Component list, select longitudinal.
4. Set the Independent Axis to Time.
5. Select Add Curves.

ADAMS/PostProcessor displays the plot you just defined.
Next Step

You have now completed all of the ADAMS/Car tutorials. For more information on using ADAMS/Car, see the online help or the online guides.
## Index

### Symbols

| .dcd files, about | 138 |
| .def files, about | 136 |

### A - B

**ADAMS/Car**
- benefits of using | 8
- described | 6
- modes | 6
- starting Standard Interface | 9
- starting Template Builder | 11
- using | 7

**ADAMS/Car menus, using** | 13

**ADAMS/Car pop-up menu, using** | 14

**ADAMS/Car Standard Interface**
- about | 6
- starting | 9

**ADAMS/Car Template Builder**
- about | 6
- starting | 11

**ADAMS/Flex, about** | 52

### Analyses

- about | 7
- comparing results of | 46
- elasto-kinematic | 120
- ISO lane-change | 135
- kinematic | 116
- pull | 35, 45
- quasi-static steady-state cornering | 132
- results, using | 7
single lane change 127
suspension ride 27
  types of 21
Analysis types, compared 21
Animating results 28, 35, 118
Assemblies
  analyzing 7
  closing 49
  creating 7, 24
  opening 125
Assumptions in this guide 3, 16
Attachments, about creating 80
Bushings, creating 99, 100, 102

C - D
Changing
  magnification 128
  rendering mode 86
  user mode 11
Characteristic of flexible bodies 52
Comment tool, using 22
Communicators
  about 107
  creating 109
  defining 108
  displaying information about 108
  naming 109
  testing 111
Compliant mode
  about 96
  setting 120
Construction frames
   about 94
   creating 94

Control arm
   about 84
   attachments 97–100
   bushings for 99
   creating 85
   creating geometry for 86
   hardpoints for 84
   revolute joint for 100

Creating
   assemblies 24
   communicators 109
   construction frames 94
   control arm 84
   damper 89
   hardpoints 80
   hooke joint 104
   hub 94
   parts 80
   plots 36
   revolute joint 100
   spherical joint 100
   spring 92
   strut 89
   suspension assembly 55, 116
   suspension subsystem 22, 114
   templates 81
   tie rod 92
   toe and camber variables 93
   translational joint 96
   wheel carrier 87
Damper
    creating 90
    hardpoint for 89
Damping ratio for flexible bodies
    about 54
    defaults 54
Data control files (.def) files, about 136
Deleting
    plots 31
    simulations 49
Designing templates 78
Displaying
    gravity icon 81
    information about communicators 108
Driver control data files (.dcd) files, about 138

E - F
Elasto-kinematic analysis
    about 120
    performing 120
    plotting 120–121
Exiting Template Builder mode 113
Expert mode, changing to 11
Fit to View command 82
Flexible bodies
    about 52
    changing inertia modeling 61
    characteristics 52
    creating outlines of 60
    damping ratio 54
    displaying information about 57
    integrating in templates 52
    managing 57
Getting help online, about 17

Full-vehicle analysis (with flexible body)
about 73
animating results of 64

Full-vehicle assembly
analyzing 73
creating 66

Gravity icon, displaying 81

Hooke joint, creating 104

Hub
attachment 105
construction frame 94
creating 94
cylinder geometry for 95
locking to wheel carrier 108

Getting Started Using ADAMS/Car
Index
I - J
Icon visibility, settings  81
Inertia modeling of flexible bodies, changing  61
Information window
   about  57
   displayed  58
ISO lane-change analysis, about  135
Joint, creating
   revolute  100
   spherical  100
   translational  96
K - L
Kinematic analysis
   about  96
   animating results of  118
   performing  117
   plotting results of  118
Kinematic mode, setting  68, 117
Linear superposition, using principle of  52
Loadcase file
   about  32
   defining  32
   storing  33
   using  35
   values  34
M - N
Magnification, changing 128
Message window, role of 25, 28, 54
MNFs, See Modal neutral files
Modal flexibility, about 52
Modal neutral files
   about 52
   replacing graphics for 60
   swapping 69
Mode Manager, using 59
Modes
   animating 58
   disabling 71
   displaying 58
   displaying frequency for 59
   enabling 71
Modes method, about 52
Modifying
   hardpoint locations 43
   subsystems 42
Mount part
   creating 98, 101, 104
   discussed 97
New subsystem, creating 22, 114
Node numbers
   about 69
   use of 69
O - P

Online help, about 17
Opening an assembly 126
Parallel wheel travel analysis
   animating results of 28
   performing 27
   plotting results of 29
Parameter array, creating 106
Parameter variables, defining 93
Parts
   creating 80
   creation methods 83
   general 80
   suspension, building 83
   types of 80
Play-forward tool 28, 118
Plot Builder, using 36, 39
Plot configuration file
   discussed 29
   saving 42
   using 29
Plot layout, modifying 132
Plot subtitles, modifying 132
Plot titles, modifying 132
Plots
   deleting 31
   scrub radius 29, 40, 41
   steering wheel torque 47
   toe angle 119, 121
   viewing 29
Getting Started Using ADAMS/Car

Index

Plotting
- elasto-kinematic analysis 120–121
- kinematic analysis 118
- modifying plot axes 41
- pull analysis results 36, 46
- ride analysis results 29

Private configuration file, modifying 11

Property files, discussed 89

Pull analysis
- animating results of 35
- performing 35, 45
- plotting results of 36, 46

Q - R

Quasi-static steady-state cornering analysis, about 132

Rendering mode, changing 86

Reset tool, using 129

Revolute joint, creating 100, 105

S - T

Saving
- plot configuration 42
- subsystem 24
- subsystems 115
- templates 113

Scrub radius, plotting 39

Simulation modes, about 96

Simulations
- deleting 49
- increasing efficiency of 71
Single lane-change analysis
  about 127
  performing 127
Spherical joint, creating 100, 103
Spring
  about 90
  creating 92
  equations for 90
  hardpoint for 91
Standard Interface
  about 6
  starting 9
Starting ADAMS/Car Standard Interface
  in the UNIX environment 10
  in the Windows environment 9
Starting ADAMS/Car Template Builder
  in the UNIX environment 12
  in the Windows environment 11
Static load analysis, performing 63
Steering axis
  about 106
  creating 106
  discussed 42
Strut, creating 89
Subsystem
  creating 22, 114
  modifying 42
  saving 24, 115
Suspension assembly, creating 55, 116
Suspension parameters, defining 93
Suspension parts, building 83
Suspension subsystem
  creating 114
  modifying hardpoints for 115
  saving 115
Symmetric pairs, creating 84
Template Builder
  about 6
  exiting 113
  starting 11
Templates
  creating 81
  creating topology for 80
  defined 20
  designing 78
  integrating flexible bodies in 52
  saving 113
Tie rod
  creating 93
  hardpoint for 92
Toe and camber variables, creating 93
**Toggle Icon Visibility** command 81
Translational joint, creating 96

**U - V**
User mode, changing 11
User-entered method, about 83
Variables, creating for toe and camber 93
Vehicle parameters, defining 25
W - Z

Wheel carrier
  attachments  103–104
  creating  88
  hardpoints for  87
  adding link geometry  88

Zooming
  on a specific area  60
  on the main window  128